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ccording to popular legend, a Mac is so easy to use that you don't need to read books about

it. Alas, if only that were true. The fact is that harnessing all the power of Mac OS X would

take a substantial amount of time of exploring and tinkering, and not everyone has the
time, the inclination, or the patience to devote to the mastery of an operating system. Save your
time for having fun with games, surfing the Internet, or perhaps getting some work done. Benefit
from the experience of others (in this case, we the authors)! Read this book so that you can lever-
age the full power of OS X without a lot of ambling around the desktop.

You might be under the impression that you don’t need this book because of Apple’s supplied Mac
OS X Getting Started Guide and on-screen help. Though these are good sources of information, the
Mac OS X Leopard Bible contains a great deal of information and how-to guidance that you won't
find anywhere else.
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rom the moment you see Mac OS X, you know that it’s different from

any other computer operating system on the planet, including earlier

iterations of Mac OS. Nothing else looks quite like it. Yet, use it a bit
and you'll see that there is familiarity about its operation. Apple has made
great efforts to ensure that Macintosh users as well as Windows users can
leverage their previous OS skill sets. But what sets Mac OS X apart from its
predecessors and its competition is the sum total of its parts.

This chapter provides an overview of the core technologies that comprise
Mac OS X. Knowing the core technologies can help you master the overall
operation of this world-class operating system. The chapter concludes by
examining the system requirements of Mac OS X and its installation.

What Is Mac OS X?

Mac OS X is Apple’s answer to the quest for a modern operating system. It
combines the power and stability of Unix with the simplicity of Macintosh.
In 1996, after continual failed attempts to develop its own next-generation
operating system, Apple management looked outside the company and
acquired NeXT Software, Inc. NeXT'’s OS at the time was called OpenStep.

It had all the features that Apple desired in a modern OS: protected memory,
preemptive multitasking, multithreading, and symmetric multiprocessing.
With OpenStep as the foundation, Apple initially designated the code name
Rhapsody for its new OS, but as the project matured, it was renamed to Mac
OS X, keeping in line with the progression of Apple’s existing system soft-
ware monikers. Apple has enjoyed phenomenal success with Mac OS X,
which has been adopted by over 5 million users, and Apple is now generally
considered the largest vendor of Unix-based systems on the planet.

IN THIS CHAPTER

What is Mac OS X?

Understanding the core
technologies of Mac OS X

Reviewing the installation
process

Installing Mac OS X

Running the Setup Assistant

Running Software Update




Getting to Know Mac OS X

Mac OS 10.5 is another evolutionary step in the OS X product line. Apple claims it has more than
300 enhancements. One of the more significant enhancements, though most likely unperceivable
to most users, is that the product is now a 64-bit Universal OS that is capable of running 32-bit
software without recompilation. What does this mean in layman’s terms? Mac OS X 10.5 can be
installed on both Intel and PowerPC CPU-based Macs and will continue to run your existing Mac
OS X application.

B Mac OS X is capable of addressing up to a whopping 16 exabytes of virtual memory.
: % An exabyte is equivalent to 1,024 petabytes, and a petabyte is equivalent to 1,024
terabytes — that’s a lot of memory.

Core Technologies of Mac OS X

The most important thing to know about Mac OS X is that it is based on open standards. This is
because at the heart of OS X is Unix, which has played a major role in the development of the
Internet. Because Unix is so Internet-centric, OS X can be integrated in virtually any computing
environment. In fact, the X in Mac OS X represents the X in Unix. But fear not; although Mac OS X
is a Unix operating system, its operation does not require the mastery of complex Unix command
syntax. As Apple publicizes, the command line is there for those who would like to use it, but it
isn't required for day-to-day operations. You can make as much or as little use of it as you want.

If OS X were compared to an automobile, you would see a similarity in that both are composed

of many parts. All these parts have very distinct functions, and yet all make up a greater whole.
Metaphorically speaking, the intention of Apple was to design a vehicle akin to a Formula 1 racing
car. When the engineers at Apple set out to build OS X, they pulled together world-class technolo-
gies in an effort to build the most advanced consumer operating system the world has ever seen.
The following sections take a closer look at these parts.

Darwin

The foundation of OS X is Darwin, which is an open source community/Apple joint effort. Though
Darwin is a complete OS in and of itself, the primary objective of the Darwin project was to build
an industrial-strength Unix-based operating system core that would provide greater stability and
performance compared to all existing iterations of the Mac OS. Reviewing Darwin in detail is
beyond the scope of this book. Instead, we review some of Darwin’s more marketed features.

Mach microkernel

At the center of Darwin is the Mach microkernel based on FreeBSD 5.x, the foundation that pro-
vides basic services for all other parts of the operating system. Mach was developed at Carnegie-
Mellon University, and its history is closely tied with BSD Unix (Berkeley Software Distribution).

It is Mach that gives OS X the features of protected memory architecture, preemptive multitasking,
and symmetric multiprocessing.
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Protected memory

Protected memory isolates applications in their own individual memory workspaces. When an
application crashes, the program can be terminated without having a negative effect on other
running applications or requiring a restart of the computer.

Advance memory management

Advance memory management automatically manages physical RAM and virtual memory dynami-
cally as needed. Virtual memory uses hard disk space in lieu of physical RAM. Information that
would normally sit in RAM, but is not currently needed, is transferred to the hard disk to free up
physical RAM for the demands of data/applications that need it. This alleviates out-of-memory con-
ditions and eliminates the need, experienced by users of previous Macintosh desktop operating
systems, of having to manually adjust memory allocations.

Preemptive multitasking

Mac OS X, like all Mac OS versions since System 7, allows more than one application to be open
and operating at the same time. This capability is known as multitasking. Prior to OS X, the Mac OS
employed a version of multitasking referred to as cooperative multitasking. In cooperative multitask-
ing, applications sometimes seemed unresponsive because the system software could not efficiently
manage the concurrent demands of multiple running programs. Mac OS X remedies this by imple-
menting preemptive multitasking. Preemptive multitasking prioritizes processor tasks by order

of importance. This more efficient method of managing processor tasks allows the computer to
remain responsive, even during the most processor-intensive tasks.

Symmetric multiprocessing

Symmetric multiprocessing (SMP) provides support for multiprocessor Macintosh computer sys-
tems. This allows applications to take advantage of two or more processors by assigning applications
to specific processors or by splitting parts of applications, known as threads, between multiple
processors simultaneously. Mac OS X is further optimized to take advantage of SMP by employing
a technique known as optimized kernel resource locking. Optimized kernel resource locking provides
superior SMP performance by allowing multiple CPUs access to different portions of the kernel
simultaneously. Mac OS 10.5 takes multiprocessing another step forward with its multicore proces-
sor competency, allowing it to harness the power of up to eight cores simultaneously, which is the
maximum number of cores shipping inside of Macintosh computers at the time of this writing.

Graphics technologies in Mac OS X

When it comes to graphics, Mac OS X is one of the most powerful operating systems on the planet.
To achieve this power, Mac OS X employs several standards-based technologies that are best-of-
class. These technologies include Quartz, OpenGL, and QuickTime. Over the past couple of years,
some of the greatest strides in hardware performance have come in the form of video hardware.
Mac OS X 10.5 has been optimized to take advantage of this high performance video hardware.
Designated as Core Image and Core Animation, this software optimization improves performance
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by reducing floating-point unit (FPU) CPU utilization by offloading it to the Graphic Processing
Unit (GPU) of the video hardware. Not all video cards are Core Image/Animation capable, but it’s
safe to assume that if your Mac has shipped within the last two years, it will be either fully or par-
tially compliant, because the technology is scaling and is dependent upon hardware capabilities.
For a complete list of Core Image/Animation-compliant video cards, visit www . apple. com.

Quartz

Quartz is a powerful two-dimensional (2-D) graphics-rendering system. It has built-in support
for the Portable Document Format (PDF), on-the-fly rendering, compositing, and anti-aliasing.
It supports multiple font formats, including TrueType, PostScript Type 1, and OpenType. Quartz
supports Apple’s ColorSync color-management technology, allowing for consistent and accurate
color in the print/graphics environment.

OpenGL

Open Graphics Library (OpenGL) started out as a technology initiative by Silicon Graphics, Inc.,

a manufacturer of high-end graphics workstations. It has since become an industry standard for
three-dimensional (3-D) graphics rendering. It provides a standard graphics application program-
ming interface (API) by which software and hardware manufacturers can build 3-D applications
and hardware across multiple platforms on a common standard. OpenGL is very prevalent in gam-
ing, computer-aided design (CAD), professional 3-D animation/modeling, and graphic design.

QuickTime

QuickTime is Apple’s cross-platform multimedia authoring and distribution engine. It’s both a file
format and a suite of applications. QuickTime has been around since 1991 and has matured into a
very powerful technology. It supports more than 50 media file formats encompassing audio, video,
and still images. Some examples of these file formats include AIFE, AV, JPEG, MIDI, MP3, MPEG-1,
PICT, and TIFE QuickTime has support for real-time video streaming, allowing viewers to tune in
to live or prerecorded content on demand.

Aqua

Though Aqua is not a graphics technology in Mac OS X, it is its graphical user interface (GUI).
Appearance-wise, it is a dramatic departure from OS 9% Platinum interface, although it retains cer-
tain common elements. This allows for greater familiarity for legacy Macintosh operators, thus
making the transition to OS X a more intuitive experience.

Mac OS X'’s application environments

Application environments allow Mac OS X to run its modern OS-enabled applications while simul-
taneously supporting legacy Mac OS software. An application environment consists of various sys-
tem resources, components, and services that allow an application to function. Mac OS X has five
application environments: Cocoa, Carbon, Java, BSD, and Classic.
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Cocoa

Cocoa applications are specifically developed for Mac OS X. Cocoa applications are incompatible
with older Macintosh operating systems and, therefore, do not run on Mac OS 9. Cocoa applications
take advantage of all of Mac OS X’s modern OS features, such as advance memory management,
preemptive multitasking, symmetric multiprocessing, and the Aqua interface. Apple evangelizes
Cocoa for its modern object-oriented programming techniques and rapid application development
tools, which make application development significantly faster and easier than for Carbon. Some
examples of Cocoa applications are OS X’s Mail and Preview applications as well as Netopia’s
Timbuktu for Mac OS X.

Carbon

The greatest advantage of the Carbon application environment is that developers can build applica-
tions that run in either Mac OS 9 or OS X. When running within OS X, Carbon applications take
advantage of most of OS X’ modern OS features, including the Aqua interface. In order for Carbon
applications to run within Mac OS 9, the CarbonLib library must be present within the Extensions
folder within the Mac OS 9 System folder. Ironically, some Carbon applications do not run under
Mac OS 9. The most prominent is Microsoft’s Office Version X for Mac.

Java

The Mac OS X Java environment is Java 2 Standard Edition-compliant. It can run both Java appli-
cations and applets. The key advantage of Java development is that Java applications can run on
any platform that contains a cross-compatible Java Virtual Machine.

BSD

The BSD application environment usually deals with command-line executable shell scripts. A
shell script is similar to an MS-DOS batch file in that they’re both text files that contain a sequence
of commands. Interestingly enough, shell scripts do not necessarily have to be executed from the
command line. Shell scripts can be implemented within Cocoa applications, allowing them to be
executed from the GUL

Packages and bundles

A package, sometimes referred to as a bundle, is a single-icon, point-and-click representation of an
application. Mac OS X’s Carbon and Cocoa applications can be comprised of multiple subordinate
files and resources. In the GUI, all of these subordinate pieces are neatly wrapped up into a repre-
sentation of a single executable file for the end user. To view the contents of an application package,
simply press and hold the Control key while highlighting the Carbon or Cocoa application icon.
You're then provided the option to show the package’s contents. For illustration purposes, Figure 1.1
depicts the contents of Safari for Mac OS X.

Frameworks

Mac OS X frameworks contain dynamically loading code shared by multiple applications.
Frameworks alleviate the need for applications that contain common code to individually load that
code for each instance of those applications running simultaneously.
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When pondering packages remember the whole is greater than the sum of its parts.
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Installation Considerations for Mac OS X

Now that we have reviewed the core technologies of Mac OS X, let’s focus on its installation process.
Although Mac OS X has a very structured installation process, several variations of installation are
available. The user’s needs dictate the appropriate installation strategy. However, before any Mac
OS X implementation can take place, it is necessary to evaluate the target computer to see whether
it meets Apple’s official hardware requirements.

Hardware requirements of OS 10.5

Apple’s minimum hardware requirements for Mac OS X 10.5 is a factory-shipped Intel or PowerPC
G4 867MHz processor with 512MB of RAM (1GB with Developers Tools), 9GB of available hard
drive space (12GB with Developers Tools), a DVD drive, a built-in FireWire port, and an Apple-
supplied video option. In addition, Boot Camp requires an Intel processor and will run either
Windows XP Service Pack 2 or Windows Vista (BYOOS — bring your own OS). Photo Booth
requires an iSight camera (built-in or external), USB video class (UVC) camera, or FireWire DV
camcorder, and an Intel or PowerPC G5 processor. Backdrop effects require an Intel Core Duo or
faster processor. Backdrop effects when using a DV camcorder require fixed focus, exposure, and
white balance. iChat Video requires an iSight camera (built-in or external), a USB video class
(UVC) camera or FireWire DV camcorder; and a 128-Kbps upstream and downstream Internet
connection. Audio chats require a microphone and a 56-Kbps Internet connection. Front Row,
Apple’s entertainment media console, requires a Mac with built-in IR and an Apple Remote.
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Leopard’s revised DVD Player requires a 1.6GHz processor or faster for improved de-interlacing.
As for third-party hardware, Apple states that OS X natively supports many third-party hardware
devices, although some devices may require additional driver updates from their respective manu-
facturers to utilize a product’s full feature set.

Preparing for the installation of OS X

After you've deemed that the target hardware meets OS X’ minimum hardware requirements, you
need to verify that the target computer’ firmware is up to date. Firmware is programming that tells
a computer’s hardware how to behave. Starting with the original iMac, Macintosh computers have
used a firmware-upgradeable hardware design. This design element on PowerPC Macs is a compo-
nent of what is referred to as NewWorld Architecture. Intel Macs have an equivalent known as
Extensible Firmware Interface (EFI). The Mac’s firmware is contained in a programmable (flash-
able) read-only memory (PROM). This programmable firmware approach enables Apple to fix
technical issues via patches and upgrades like any other software. As a result, this innovation
allows Apple to achieve greater hardware stability and overall improved system performance via
firmware updates. Using a utility referred to as a Flash-ROM updater, firmware can be upgraded
(sometimes referred to as revved). The Mac OS 10.5 installer alerts you if your system’s firmware

is out of date. You can also determine your system’ firmware by running Apple System Profiler.
Apples latest firmware may be included on the Mac OS X Install DVD. It can also be obtained
either through Mac OS X5 built-in Software Update mechanism or from www. info.apple.
com/support/downloads.html.

B All PowerPC system firmware updaters released to date by Apple prior to the G5

458 are available via Mac OS 9 applications only. Updating a system’s firmware using the
Classic application environment in lieu of booting directly from Mac OS 9 is not recommended and
Classic is no longer officially supported within Leopard.

Volume preparation for OS X

A Mac OS X startup volume can be formatted as an Extended (HFS+) or a Unix File System (UFS)
volume. An HFS+-formatted volume’s single biggest advantage is that it can be prepared as either
case preserving or case sensitive. All Macintosh desktop operating systems to date have used file sys-
tems that have been dependent on case-preserving formatted volumes (this includes the old HFS
format as well).

The opposite of the case-preserving format is the case-sensitive format. With the case-sensitive
format, it is possible to have multiple files named identically in the same location/folder/directory.
The only thing that would differentiate the files to the naked eye is the varied use of uppercase and
lowercase characters. For example, you may have individual files named DOG, DoG, Dog, dOg,
doG, dOG, and dog located in the same folder.

As mentioned previously, OS X also supports another format referred to as the Unix File System
(UFS), although it isn't the preferred volume format because it doesn’t support AirPort networking
and is case sensitive. In addition, UFS volumes are not recognized by Mac OS 9 and their volume
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names cannot be customized after creation. Apple states that “a UFS format may be desired for
developing Unix-based applications within OS X,” and you should not choose this format unless
you specifically need it.

Gathering setup information

Regardless of whether you're upgrading from Mac OS 9 or older versions of Mac OS X, if you want
your computer to use the same Internet and network settings, before you install Mac OS X on it you
need to make a note of your system’ current preferences. Depending upon how you connect to the
Internet, one or more of the following settings may need to be recorded. In Mac OS 9, the settings
are located in the AppleTalk, File Sharing, TCP/IP, Remote Access, Modem, and Internet control
panels. In Mac OS X, the settings are located in the Network and Sharing preference panes as well
as in the Internet Connect application. In addition, you may need to get the settings for your
e-mail account from your e-mail reader application.

Hard drive backup

To back up today’s large hard drives, you need some type of storage device that can accommodate
the capacity of your backup. These devices can include, but are not limited to, another internal
IDE or SATA hard drive, a FireWire or USB hard drive, or a recordable optical or magnetic media
drive. You can back up to a Finder-accessible volume by simply dragging and dropping the desired
contents to another hard drive; however, before doing so, you need to be the owner of those con-
tents and be sure to select ignore permissions from within the Get Info window of the intended
destination volume. Another option to consider is Leopard’s Time Machine backup utility, which is
covered in greater detail in Chapter 21. Lastly, using a more advanced third-party backup utility,
such as Retrospect from Dantz Development or BRU from Tolis Group, has the added benefit of
superior logging and verification capabilities to ensure the successful outcome of a backup, in
addition to the fact that both products support streaming tape media.

Preparing the destination volume

After you've backed up, you're ready to prepare your intended destination volume for Mac OS X
installation. To do so, you need to use the Disk Utility application located on the Mac OS X Install
DVD. Disk Utility is covered in Chapter 21.

If you're not installing on an Apple-branded hard disk, and third-party formatting software was
used to prepare it, you need to investigate if the formatting software is Mac OS X-compatible. If
not, you need to use formatting software that is compatible. Typically, an initialization is required,
but some third-party formatting software can update and overwrite an existing driver without the
need of an initialization.

A driver is a piece of software that enables an operating system to interface or control a hardware
device. In general, the operation of driver software requires no action from the end user. All hard
drives use driver software. It is imperative that the hard disk driver is compatible with the Mac OS
version in use or problems will result.
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Running the Mac OS X installer

After the destination volume is prepared, you're ready to run the Mac OS X Installer application,
but before doing so, make sure to have your computer plugged in if you're installing on a portable
system. You don’t want your iBook or PowerBook going to sleep in the middle of an installation. At
the time of this writing, the Mac OS 10.5 installer is contained on one DVD, though its expected
that CD media will be an available option by special request when Leopard is released. To install
OS X, you're required to boot from the Mac OS X Install DVD. You can achieve this in the follow-
ing four manners:

B Boot the Macintosh while holding down the C key.

B Use the Startup Manager. To activate the Startup Manager, hold down the Option key at
startup. You're then presented with a graphical interface that enables you to select it as a
startup disk.

B Select the Mac OS X Install DVD by using Mac OS X’s Startup Disk Preference pane.
B You can boot from a Mac OS X Install DVD by inserting the DVD while booted from Mac

OS X and locating and double-clicking the Install Mac OS X application, which requires
the authorization of an administrator’s account.

Figure 1.2 shows the Restart button in the Install Mac OS X window. When the computer starts
from the Mac OS X Install DVD, the Installer program starts automatically and presents a series of
screens that ask you to make certain choices as described in the following text.

FIGURE 1.2

The Restart button in the Install Mac OS X program restarts the computer with the Mac OS X Install DVD
to begin installation.

Install Mac DS X

Click the button below to restart
your computer and begin the
installation process.

ER!!!IR )
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Select Language

The Mac OS X installer supports installations for many languages. Select the appropriate language
for the remainder of the installation process and click Continue.

Welcome

The Welcome screen acts as a prelude to the rest of the installation process. No action is required
except for clicking Continue.

More Information

The Read Me screen presents the same contents that can be found in the Read Before You Install
document on the Mac OS X Install DVD. Skipping this document is tempting, but the information
provided may be important, so you should at least skim it. After reading the information, click
Continue.

License

The License screen presents you with OS X5 Software Licensing Agreement. The license agreement
is filled with legalese, but you may want to look through it so that you know what you're agreeing
to. For example, one provision states that you may only install the software on one computer at a
time. You must click Continue, and a second confirmation screen appears in the form of a dialog
sheet, requesting you to click Agree before you can continue with the installation process.

Make no mistake, Apples legal department perceives that the License Agreement is important; they
provide the convenience of a pop-up menu where you can choose to view it in a language other
than English.

Select Destination

The Select Destination screen enables you to choose the destination volume for your Mac OS X
installation. Click the Options button and a sheet appears, providing the choices to Upgrade Mac
OS X, Archive and Install, and Erase and Install. Here’s what those options mean:

B Install Mac OS X/Upgrade Mac OS X: Dependent upon whether a previous installation
of Mac OS X exists, the first option appears as Install Mac OS X or Upgrade Mac OS X.
Install Mac OS X installs Mac OS X for the first time on a specified volume, and Upgrade
Mac OS X upgrades an existing installation of Mac OS X while preserving current appli-
cations, fonts, and preferences.

B Archive and Install: Moves existing System files to a folder named Previous System and
then installs a fresh copy of Mac OS X. After a system folder has been designated as previ-
ous, it can no longer be used as a valid startup OS. Preserve Users and Network Settings
is a suboption under Archive and Install, which facilitates the preservation of user
accounts, home folders, and network settings.

B Erase and Install: Provides a clean slate. As with the Disk Utility, it erases your hard
disk. The Erase and Install option also allows you to choose your disk format: MAC OS
Extended (Journaled) or Mac OS Extended (Case-sensitive, Journaled). Journaling may
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help protect the data on your hard disk from unforeseen failures such as system freezing
or power outages. As previously mentioned, case sensitive means that it matters whether
or not letters are capitalized. For example, passwords in Mac OS X are case sensitive. In
some instances, such as in the screen saver password window, the dialog box tells you if
the Caps Lock key is pressed, alleviating the frustration of being sure you typed the cor-
rect password but having entered it unknowingly in all caps.

[ If there is a sole ATA/IDE hard drive in your Mac, and the Select a Destination screen
: % does not display an available hard disk to install to, you need to verify that the intended
target ATA/IDE drive is configured as a master drive on the bus.

After making your selections, click Continue.

Installation Types

The Installation Types screen provides two choices for installation types. The choices are Install and
Customize. By default, the Mac OS X installer starts with the default install which is comprised of
the packages Essential System Software, Print Drivers, Additional Fonts, Language Translations,
and X11. Upon closer inspection of the Customize Install options, you'll see the mechanism for
granularly controlling the selections of the packages that can be installed. Wise use of these selec-
tions can eliminate superfluous software from your Mac OS 10.5 install. After choosing your install
type and making your selections, click the Install button.

Installing

The OS X installer now begins to verify the condition of your installation media and displays a
drop-down dialog sheet providing a progress bar. You can skip this process by clicking the Skip
button. When the disk has been verified or skipped, the installer commences the actual OS instal-
lation, which lasts about an hour, give or take, depending upon your installation type and selec-
tions. For the most part, this is an automated process that leaves you the time-honored task of
progress-bar watching.

Finish Up
At this point, the installer performs several optimization and clean-up tasks to complete the instal-
lation process.

Stopping the Mac OS X Installer

Until you click the Install button to get the installation process under way, you can stop installa-
tion by choosing Installer => Quit Installer. If you do this, the installer displays a dialog box that
asks you to confirm that you really want to stop installation. Click the Restart button in this dialog
box to have installation stop and your computer restart. When you hear your computer’s startup
chime, press and hold the Option key to select a valid startup disk other than the Mac OS X Install
DVD. You can also eject the Mac OS X Install DVD by pressing the mouse button during restart.

13
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Using the Setup Assistant

After the Mac OS X install process has been completed, the computer automatically reboots. Next,
Mac OS X5 Setup Assistant automatically launches and you hear some snazzy music as well as see
some flashy graphics. You are also audibly prompted to choose if you would like to use Voice Over
interface technology throughout the rest of the Setup Assistant process. When this is over, you are
presented with the Setup Assistant’s Welcome screen, which, depending upon your selections, guides
you through the process of transferring user accounts from another system or volume, procuring
an Apple ID for purchasing Apple products and services online, registering your OS software, set-
ting up your first user account, and connecting to the Internet.

Welcome

The Welcome screen is where you select the country or region in which the Macintosh will be
used. To see selections beyond the default countries, click the box adjacent to the Show All label,
located under the selection widow. If you wait about 30 seconds, a modal dialogue sheet appears
querying in easy-to-see large text if you require the use of Mac OS X’s VoiceOver, Apple’s Spoken
Interface, to audibly guide you through the setup assistant process. After making your selection,
click Continue.

Do You Already Have a Mac?

The Do You Already Have a Mac? screen allows for the migration of user and system data from
another Mac, or from another volume on this Mac, or from a Time Machine backup. There is also
a selection not to transfer anything. Transferring accounts from one system or volume to another
does not affect the contents of the source. As a matter of fact, the transfer of accounts can be per-
formed at any time, by running the Migration Assistant located in the Utilities folder inside of the
Applications folder. When transferring an account from one volume or system to the next, the fol-
lowing things can be optionally migrated: Network settings, User accounts (including preferences
and e-mail), Documents, and Applications. Apple notes that some applications may not transfer
properly, thus requiring a reinstallation; and in order to play transferred songs purchased from the
iTunes Music Store, you'll need to de-authorize your old system and authorize your new one. To
transfer information from one Mac OS X system to another via FireWire, you'll obviously need a
standard FireWire cable and your Mac must be capable of FireWire Target Disk mode.

Keyboard

Simply stated, this screen allows you to select the localized keyboard layout that is appropriate for
the operation of your Macintosh specific to your geographic locality.

Select a Wireless Service

This screen assists with the facilitation of network connectivity. As the title implies, it has an obvious
slant toward wireless connectivity and displays all visible wireless networks that can be perceived.
To access a hidden wireless network click the Other Network option. Don't forget to specify your
password (WPA/WEP) if your wireless network requires one. If you do not have a wireless network
click Other Network for other options. Here is where you can configure your Mac to be directly
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attached to a cable or DSL modem as well as a local area network (LAN) via Ethernet. If none of
these options suffice, click My computer does not connect to the Internet, and you are taken to
the Personalize Your Settings screen. Later, revisit the Network preference pane within the System
Preferences application to configure your Network settings.

Enter Your Apple ID

Eerily reminiscent of Microsofts Passport, an Apple ID lets you make one-click purchases from
the iTunes Music, iPhoto, and Apple Stores. If you already possess a .Mac membership, use that as
your Apple ID; otherwise, have the Setup Assistant create one for you, or skip the process entirely.
If you do elect to create an Apple ID, you are also provided with a 60-day trial membership to
.Mac. .Mac is a combination of software and online tools that can enhance your “Internet experi-
ence” while using your Mac. After making your selections, click Continue. (For more details on
.Mac, see Chapter 14.)

Registration Information

This is the product registration that is automatically sent to Apple when you connect the Mac to
the Internet. You cannot leave anything blank except the e-mail address and the company or school.
You can skip this screen by pressing 8+Q and then pressing the Skip button, which takes you
directly to the Create Your Account screen and automatically configures your network settings for
DHCP. Otherwise, after completing the Registration Information screen, click Continue. There is
also a button for Shut Down, which can be used to shut down the Mac and allow it to be registered.

Personalize Your Settings

The Personalize Your Settings screen is where you select the keyboard layout that is appropriate
for the country or region in which the Macintosh will be used. You can change the preference later,
after you're into the computer. Make your language selection and click Continue. If you don't see
your language, click the box adjacent to the Show All label, located under the selection widow.

Create Your Account

After you've submitted the necessary registration information, you need to set up your user account.
Chapter 18 reviews user accounts in detail, but for now suffice it to say that the information you
provide is necessary to perform administrative functions within Mac OS X. When creating your
account, you'll need to specify both a Name and a Short Name. A Short Name is exactly what it
sounds like—a short name. It alleviates the need for typing your whole name. You'll appreciate
your short name when user authentication is requested by certain applications or during certain
administrative functions within OS X.

A Short Name is automatically generated when you tab from the Name field to the Short Name
field. But don’t worry — it can be changed. A short name is all lowercase, has a maximum of eight
characters, and cannot contain any spaces or the following characters: <>'"* {} [ O A1\ # | &

$2~.

15



Getting to Know Mac OS X

16

Make sure to pick a Short Name you like, because it can’t be changed after the fact. After you've
chosen your short name, you'll need to provide a password. Although OS X accepts more than
eight characters for this field, it checks only the first eight. The last entry field allows you to pro-
vide yourself an optional password hint if desired. Finally, you need to select a picture that serves
as an iconic representation of your user account. After making your selections, click Continue.

Select a Picture for This Account

This portion of the Setup Assistant allows you to take a snapshot for iconic representation of your
user account if you're using an iSight camera or your Mac has one built-in. Otherwise, you can
select one from a stock library within Mac OS X by selecting the Choose from the picture library
option.

Select Time Zone

The Select Time Zone screen allows you to specify the time zone the computer will be operating
in. Clicking your geographic location or typing the name of the closest city where the computer is
located accomplishes this. After making your selection, click Continue.

Set the Date and Time

The Set the Date and Time screen lets you to set your computer’s clock and calendar. When you’re
done, click Continue.

Don’t Forget to Register

If by chance your registration information was not successfully sent to Apple or you opted to skip
entering as discussed earlier, you'll be prompted with an additional screen stating Don't Forget to
Register; just click the Done button at the bottom to move on.

Running Software Update

Finding that the installers provided by manufacturers of media in hand do not contain the most
recent version of a product is not uncommon. Usually, software updates can be obtained via a man-
ufacturer’s Web site. Apple simplifies this process by automating the update process upon initial
OS X startup. If by some chance this does not occur, the process can be manually activated via the
Software Update preference panel. (This is reviewed in detail in Chapter 21.) Figure 1.3 shows
OS X5 Software Update preference panel, an excellent tool for obtaining the latest updates for
Mac OS X.

As you can see, building an OS X box is not a difficult task. Taking the time to evaluate your instal-
lation considerations and applying the appropriate OS X installation strategy goes a long way
toward ensuring a smooth migration from a previous Mac OS version.
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FIGURE 1.3

No installation is complete without checking for product updates.
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Summary

Mac OS X is a Unix operating system. It is built upon open standards, providing preemptive multi-
tasking, symmetric multiprocessing, protected memory, and advanced memory management, as
well as world-class graphics capabilities. Though it may be complex in design on the inside, on the
surface, it retains its world-class usability and appearance that customers expect of the Mac OS.
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his chapter will guide you through the Mac OS X environment. Not

since the introduction of Mac OS X has the Mac graphical user inter-

face (GUI, pronounced “gooey”) seen such a dramatic change. With
an updated Finder, new desktop pictures, and new screen savers, OS X just
gets better with each version. Mac OS X consists of windows, menus, icons,
and control elements. Apple calls this environment Aqua. It is an elegant,
streamlined interface, rich in color and depth; nevertheless, it is possible to
get lost as you explore the world of Aqua.

This chapter describes how to use the objects and controls in OS 10.5. You
will learn how to open, close, and resize windows; select, move, and modify
groups of icons; and delete files, use Apple’s undo command, and create
optical discs. This chapter discusses Exposé and introduces you to Spaces,
Apple’s new window management system. Most importantly, the Finder is
explored in detail, and you learn how to use Finder-specific windows,
menus, and control methods.

You will learn how to trick out your computer by customizing its appearance
and behavior, modify the layout of Finder windows, change your desktop
picture, set custom icons, and more. New features like Spaces make it easy to
keep your workspace organized. With a little effort, your workspace will not
only be functional, but stylish as well.

By the conclusion of this chapter, you will have a greater understanding of
the basic elements of OS X as well as the terms and phrases used in follow-
ing chapters. Before describing menus, windows, icons, and controls, this
chapter explains how to begin a session in the Mac OS X environment, and
concludes by explaining how you log out, restart, or shut down to end a Mac
OS X session.
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Starting Up and Logging In

Of course, when you first turn on your computer, it must go through a startup process. Startup
begins with the Apple startup chime, a signal that the most basic hardware elements are opera-
tional. After the chime, the remaining hardware tests continue as the computer tests the hard drive
for basic errors. After this, the remaining hardware elements activate as the full operating system
software loads into RAM (random access memory) from a disk.

Starting up your computer

You start up a Macintosh by pressing either of the following:

B The power button on the computer

B The power button on most Apple flat-panel displays (on some older display models, the
power button only turns the display on or off)

Once upon a time, the familiar Happy Mac icon appeared in the center of the screen while the Mac
OS loaded. Mac OS 10.2 retired “Happy Mac,” replacing it with a solid gray Apple logo. A spinning
set of bars below the Apple logo indicates that the computer is busy loading core OS elements.

Next, a Mac OS X greeting appears, together with a gauge that measures startup progress. The
spinning disk changes to an arrow-shaped pointer. This pointer tracks mouse movement, but
clicking the mouse button has no effect at this time.

Logging in to Mac OS X

After the startup process has begun and OS X has loaded all of the basic system elements and
completed activation of the kernel (background) operations, the login procedure begins. The login
procedure is the process of identifying yourself to your computer. This is both a means of ensuring
that your computer activates your particular environment (called your user account), and keeps
unauthorized people from using the computer. The login procedure is mandatory but can be auto-
mated. In fact, Mac OS X is initially configured for automatic login and remains that way unless

it is set for manual login. Upon completion of the login process, the appropriate user account is
activated and the user can interact with the OS X environment.

What login accomplishes

The login procedure accomplishes two things:

W It proves that you are authorized to use the computer.

B [t establishes which user you are, and this user identity determines what you can see and
do on the computer.

Your user identity is especially important if you or an administrator has set up your computer for
multiple users, such as members of a family or several workers in an office, because each user has
personal preference settings and private storage areas. For example, you may prefer a different
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desktop theme, and you may not want other users to have access to the data you store on the com-
puter or the application programs you use. As mentioned in the previous chapter, Mac OS X is
truly a multi-user operating system. Because more than one user account can be set up on a partic-
ular computer, it’s important to identify each user via a login. You can find information on setting
up Mac OS X for multiple users in Chapter 18.

If you have left your computer configured for the default automatic login, you do not get the dis-
tinct honor of seeing the login screen. After the startup sequence, the computer just activates your
user account, and all elements of your account are available. However, if your computer is config-
ured for manual login, Mac OS X displays a login window, and you must provide a user account
name and password before the startup process can continue. Instead of logging in, you may shut
down or restart your computer by clicking the appropriate button in the window. The login win-
dow shows one of two screens. Each is covered under the following headings. Figure 2.1 shows
examples of both types of login window.

FIGURE 2.1

When logging in to Mac OS X, you may have to type a valid account name and password (left) or you may
be presented with a list of user accounts (right).
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Logging in with a list of user accounts
If the login window shows a list of users, log in by following these steps:

1. Select your account name. Use the mouse to select your account from the list of users.
The login window contents change to show your account only, along with a field for
entering a password.

2. Type your password. Place the cursor in the Password field and enter your password; for
privacy purposes, you can't see your password — the password appears as a series of dots.
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Keep in mind that capitalization counts when entering the password; upper- and lower-
case letters are not interchangeable. If you don't know the password for the selected user
account, click the Go Back button to return to the initial login window and select a differ-
ent user. If you don’t know the password for any account, check with the person who
configured your computer for multiple users.

3. Press Return (or Enter) on the keyboard or use the mouse to click Log In. The login
window fades, and soon the Mac OS X desktop, menu bar, and Dock appear. (You can
read more about the menu bar and the other objects in later sections of this chapter.)

Logging in without a list of user accounts

If the login window shows blank spaces for user account name and password, as shown earlier in
Figure 2.1, follow these steps to log in:

1. Type your user account name. You can read the name you type. Capitalization matters
only in the password field. If you don't know both your account name and password,
check with the person who configured your computer for multiple users.

2. Type your password. Place the cursor in the Password field and enter your password; for
privacy purposes, you can't see your password — the password appears as a series of dots.
Keep in mind that capitalization counts when entering the password; upper- and lower-
case letters are not interchangeable.

3. Press Return (or Enter) on the keyboard or use the mouse to click Log In. The login
window fades, and soon the Mac OS X desktop, menu bar, and Dock appear. (You can
read more about the menu bar and the other objects in later sections of this chapter.)

Why Is Security Important?

As you do more and more important work on your computer, such as banking, reviewing credit
reports, submitting proposals to clients, trading stocks, or writing your first novel, your computer
fills up with critically important and very sensitive information. In addition, most types of high-speed
Internet connections keep your Mac available via the Internet 24 hours a day.

Through your DSL or cable modem or (heaven forbid) dial-up service, your Mac is open and avail-
able to countless computers around the world. Because of its basis in Unix (a fact that Apple market-
ing brings up at every turn), the security options you have with OS X are varied and powerful. That
being said, Mac OS X is more open to misuse because of its Unix base. Unix has had over 30 years
of evolution to enable the discovery of both loopholes and solutions to security.

Other users can turn the security options on or off, configure your computer for total remote control
via the Internet, and guess your password more easily than you might imagine. As a result, your hot
new Mac can become the new best friend of a hacker, who can steal or erase your documents as
well as launch attacks that crash your machine or network. Unix is a powerful tool. Like a hammer
or circular saw, Unix can build, but it can also destroy. The first line of defense against any type of
unauthorized access is a tough password that you keep secret.
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Dealing with login problems

If the login window shakes back and forth (like someone shaking his or her head no), either you
entered an incorrect account name or password, or Mac OS X did not recognize the user account.
The Password space clears so that you can retype the password. If you typed a user account name,
it's a good idea to retype it; simply press the tab key to highlight the account name. If you selected
a user account from a list, you can select a different account by clicking the Go Back button.

Meeting Your Environment

Once you complete the login process, you are ushered into the world of Mac OS X. Mac presents
that world to you— complete with icons, folders, menus, and the desktop — through an appli-
cation known as the Finder. The Finder, which is the core application at the heart of a user’s
interaction with the OS, is covered in greater detail later in this chapter. The following sections
explore the various commonly seen elements throughout the operating system.

= The Finder is not the same as Find. Find is a search function, designed to help users find
% documents, whereas the Finder is the system’s main program that helps launch other
applications (like TextEdit or Safari), and allows for exploration and viewing of drives, disks, and the
folders they contain.

Investigating menus

The Macintosh OS uses menus to present lists of commands and attributes. You can issue a com-
mand or put an attribute into effect simply by choosing it from a menu using the mouse. Menus
can take up a lot of space on the screen, so they remain hidden except for their titles. When you
want to see a complete menu, click its title with the mouse, and voila, you are presented with the
content of the menu!

Choosing a command or attribute generally changes the state of an object. This object may be
something you selected in advance, such as text that you want to make a different size. The object
of a menu command may instead be an implicit part of the command, such as displaying a list of
general preference settings when you choose the Preferences command from an available menu.

Although you always see menu titles in the menu bar at the top of the screen, menus can also
appear outside the menu bar. For example, a pop-up menu may appear inside of a dialog box. You
can see that these menus are available through the clever display of a distinctive arrow. In addition,
the Mac OS can display contextual menus as a response to Control+clicking a particular object.
The options and actions presented in the contextual menu are populated according to what the
selected object is.

Using the menu bar

The menus in the menu bar at the top of the screen contain commands that are relevant to the
application you are using at the time. The menus may also contain attributes that apply to objects
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FIGURE 2.2
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that you utilize within the application. Menu titles appear in the menu bar, and you can use the
mouse to display one menu at a time beneath its title. The menu bar is shown in Figure 2.2 as it
initially appears in Mac OS X, with the application menu displayed.

The menu bar is a permanent fixture at the top of the screen. Note the application menu’s title shows the
name of the active application, in this case Finder.
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To use the menu bar, position the mouse pointer over a menu title and click the mouse button
once. The commands appear beneath the menu title so that you can see all of your options.

To choose a menu item, position the pointer over it to highlight it and click the mouse button.
The menu item you choose flashes briefly and the menu fades away. The menu items effect is then
applied or a dialog window appears giving you more options.

Some menus have menus within them, aptly known as submenus. A distinctive black arrow point-
ing to the right indicates submenus. When your mouse navigates over a menu that contains a sub-
menu, the pullout menu appears, displaying its options. See Figure 2.3.

When a command is not available or applicable to the current circumstances, it is dimmed out. A
dimmed items’ text is a faded, translucent gray, rather than the normal black solid text. In Figure
2.3, Import Image is an example of an unavailable command.

In Mac OS X, unlike previous Mac OS versions, an active menu stays open indefinitely until you
make your selection. With a menu displayed, you can leave your finger off the mouse button and
move the pointer up and down the menu, highlighting each menu item as the pointer passes over
it. You can close a menu without choosing an item from it by clicking the mouse button when the
pointer is on the menu’s title or anywhere outside the menu.

While looking at any menu in the menu bar, you can activate a different menu by positioning the
pointer over the other menus title. You can click any menu item you see to choose it, or click out-
side any menu to stop looking at menus in the menu bar.
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Why One Menu Bar?

he Mac OS has a permanent menu bar at the top of the screen for several reasons. One reason is

that a menu bar at the top of the screen is an easy target to hit with the mouse. You can quickly
slide the mouse pointer to the top of the screen, where it automatically stops at the menu bar. If the
menu bar were at the top of a window in the middle of the screen (as in Microsoft Windows), you
would have to take more time to position the pointer carefully over the menu bar.

The second reason is that having a permanent menu bar at the top of the screen gives you a reliable
place for every application’s commands. If each window on the screen had its own menu bar, you'd
have to think about which one you wanted to use. Of course, Apple’s method can also result in confu-
sion because users must keep track of which application is active and responding to menu commands.

FIGURE 2.3

Pullout menus are a useful supplement to standard menus.
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Understanding standard Mac OS X menus

In most Mac OS X applications, the left side of the menu bar includes several of the following stan-
dard menus:
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Apple: Located at the left end of the menu bar, the Apple menu has a miniature solid
Apple logo for its title (unlike the six-color striped Apple menu logo in OS 9). Use this
menu to get basic information about your Macintosh, update Apple software, modify
System Preferences, or change Dock preferences. You can also use this menu to open a
recently used application or document, or to force applications to quit. Additionally, the
Apple menu has commands for putting the computer into sleep mode, restarting it, shut-
ting it down, or logging out of your user account.

Application menu: This menu is next to the Apple menu and is unique to the active
application. It’s the only menu that doesn’t always display the actual name of the applica-
tion; for example, when in Microsoft Word, the Application menu is titled Word. This
menu includes commands that apply to the application as a whole. Use the application
menu to get information about the current application, change preferences, get services
from other applications (as described in Chapter 9), hide the current application or all
others, or quit the application when you are done using it.

File: Positioned next to the Application menu, the File menu contains commands that
affect a whole document (or file), such as New, Open, Close, Save, and Print. Usually,
applications that don't use documents don't have a File menu (video games, for example).
More information on most of these commands is available in Chapter 5; the Print com-
mand is covered in Chapter 16.

Edit: Located to the right of the File menu, the Edit menu contains commands that you
can use to change a document’s contents, such as Undo, Cut, Copy, Paste, and Select All.
Read more about these commands in Chapter 5.

Window: This menu item enables you to zoom (maximize) or minimize the active win-
dow, or bring all the listed windows in front of windows belonging to other applications.
The Window menu lists other windows that belong to the same application and also may
have additional commands for window manipulation.

Help: This menu item gives you access to on-screen help. This menu is located immedi-
ately to the right of the last application-specific menu in the menu bar. In some cases, the
application may have its own help menu, and the OS X Help menu may not be present. If
this is true and you want to open the OS X Help, you can either switch to an Apple-made
application such as the Finder or use 8+? . Chapter 8 has more information on the Help
menu.

The right side of the menu bar is typically populated with system-specific menus like these:

B Clock: The Clock menu is on the right side of the menu bar and has a digital clock or an

analog clock as its title. Click the clock to display the menu, which shows the current
date, and enables you to switch between digital and a very small analog clock, and to
open the Date & Time pane of the System Preferences application, which is covered in
Chapter 17.

Sound: The Sound menu usually appears next to the clock in the menu bar and enables
you to adjust the computer’s volume. This menu has a speaker icon as its title, and it sub-
tly indicates the current sound level by an ever-increasing number of audio lines emitting
from the speaker. A setting in the Sound pane of the System Preferences application deter-
mines whether the sound menu appears in the menu bar, as described in Chapter 17.
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W AirPort: The AirPort menu appears if your computer has an AirPort wireless networking
card installed (all new Macs do). This menus title icon shows four arcs (resembling a
baseball field) that indicate the strength of the wireless network signal. You can use the
AirPort menu to join a wireless network, create a wireless network, or turn the AirPort
card off and on. With Mac OS X Apple has updated the AirPort menu. A padlock appears
to the right of secure wireless networks. On the other hand, open networks simply dis-
play the network name without a padlock. It’s a great way to quickly gauge the status of
wireless networks. See Figure 2.4. Chapter 11 covers AirPort in much greater detail.

FIGURE 2.4

On the left side of the menu bar is the AirPort menu.
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Each application may omit some of these menus and add its own menus on the left side, between
the Edit menu and the Help menu. The menus on the right side of the menu bar may appear in a
different order, and you can reorganize them according to your preference. In addition, the menu
bar may have more icons with menus on the right side of the menu bar. For example, the menu
bar may have an iChat icon, with a menu for setting your availability, viewing Buddy status, or
switching between iChat or Jabber Buddies as discussed in Chapter 6.

Using pop-up menus

A pop-up menu appears within a dialog box or a control palette when you click the pop-up menu’s
title. The title may be a text label or an icon, and is marked with a pair of arrows pointing up and
down to indicate that clicking it displays a pop-up menu. The menu may also be marked with a
single arrow pointing to the right. As with the menus in the menu bar, you can display only one
pop-up menu at a time. If a pop-up menu is open, it goes away automatically if you click the title
of another pop-up menu. An example of a pop-up menu can be seen in Figure 2.5.

Using contextual menus

Searching through menus to find a particular command isn't much fun. Wouldn't it be better if all
you saw were relevant commands? That’s the beauty of contextual menus — they offer commands
that make sense in a given context. You can display a contextual menu by pressing and holding the
Control key while clicking an icon or right-clicking (if you use a multi-button mouse) a window or
some selected text for which you want to choose a command or attribute. The contextual menu
lists commands relevant to the item that you clicked. A contextual menu is shown in Figure 2.6.
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An arrowhead marks a pop-up menu in the Print dialog box.

Printer: [ C3P0 @ Woods Family Computer 1% (&)

LTI Standard

Last Used Settings

Copies
Pages Save As...
[ e ]
Paper Size.E Ty see——TY

FIGURE 2.6

Pressing the Control key while clicking an item may display a contextual menu.
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You can Control+click one item or a selection of several items. Control+clicking a selection of sev-
eral items displays a contextual menu of commands that pertain to the whole group. Selecting sev-
eral items is discussed later in this chapter.

With a multi-button mouse or trackball, you can display contextual menus by simply
pressing the right button. If your multi-button mouse or trackball does not already work
this way, you can program it to simulate a Control+click whenever you press the right button. For
instructions on programming a multi-button mouse or trackball, see the manufacturer’s documenta-
tion. In 2005 Apple began shipping all of their systems with multi-button mice. Before purchasing a
multi-button mouse, check with the manufacturer to ensure that Mac OS X supports the device.

Menu symbols

A variety of symbols may accompany a menu item. A triangle pointing to the right at the end of an
item indicates that the menu has a submenu. An ellipsis (...) at the end of the item name indicates
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that choosing the item opens a dialog box that requires additional information before a command
can be completed. The following list summarizes these symbols and their meanings:

v Designates an item that is currently selected or an attribute that applies to everything that is
currently selected.

— Designates an attribute that applies only to some things that are currently selected.

[ ] Designates a document that has unsaved changes; some applications use it instead of v to
designate an attribute that applies to everything that is currently selected.

* Designates, in some applications, a window minimized in the Dock; designates, in the
Classic environment’s application menu, an application that requires your attention.

[ Designates a menu item with a submenu.

Other symbols are used to specify keyboard shortcuts for menu items. Pressing a specified combi-
nation of keys has the same effect as choosing the menu item. For example, pressing #8+X is equiv-
alent to choosing the Cut command from the Edit menu. The following symbols represent keys:

8 Command key
4o Shift key

X Option key
A Control key
(94 Delete key

When you use a keyboard shortcut for a command in a particular menu, the title of the menu may
flash briefly to indicate that the command has been issued. Learning these keyboard shortcuts is a
useful method for improving your control over the OS (and impressing your co-workers).

Recognizing the Desktop

The beautiful expanse of space that appears behind the menu bar and Dock is called the desktop.
Initially, the only items on the desktop are your installed hard drives and any inserted disks, but
other icons may appear. For example, an icon appears on your desktop for each file server, if any,
to which your computer is connected. All of these different icons normally appear on the desktop,
but you can hide them by changing settings in Finder Preferences.
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In actuality, the desktop is a folder, stored in your home folder (described later in this chapter). The
contents of the Desktop folder are always displayed on-screen, so users always have a location to store
and retrieve items quickly. Mac OS X keeps your desktop’s contents and appearance separate from
users who log in with other user account names. Each user account has its own Desktop folder.

Although the icons of hard drives, CDs, and other disk volumes may appear on the desk-

- S5 top, your Desktop folder does not contain these items. The icons of disk volumes appear
on the desktop simply because the Finder displays them there (together with other items actually
stored in your Desktop folder). This can be confusing, because it goes against the understanding of
folders containing the items they display, but it is the only exception to this rule.

Customizing the desktop

The desktop, as you know, is the large expanse of color that comprises the background of your
Mac OS environment. By default, this area has a stunning image of space (see Figure 2.7) ostensibly
to lead you into the future of the Mac operating system. You may want to change the color to
black, red, or your favorite color, or you may want to place a picture of your children or your
favorite celebrity as a desktop picture. To make this change, you must delve into the Desktop &
Screen Saver System Preference.

FIGURE 2.7

OS X’s new desktop picture, Aurora, is a knockout!

Leapard HD

B

Macintosh HD




Exploring the GUI and Personalizing Your Workspace

Setting the desktop background

You can cover the desktop with a solid color or a picture by choosing an image file as follows:

1.

Click the System Preferences icon in the Dock (or select Apple = System
Preferences). The System Preferences window appears, showing buttons for different
types of settings.

In System Preferences, click the Desktop & Screen Saver button or choose View =
Desktop & Screen Saver. The System Preferences window changes to show one of the
two panes in this preference panel. The settings for changing the desktop background are
of course under the Desktop pane. Click the Desktop button if it isn't already selected
(top left) to reveal the Desktop pane. Divided into two distinct frames, the left side con-
tains a list of options, and the right side is populated dynamically according to which list
item you select on the left. The Desktop pane is shown in Figure 2.8.

FIGURE 2.8

Mac OS 10.5 debuts a number of new desktop images.
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3. Select either a picture or a solid color for your background.

4. Close the window with the red Close button to complete setting the preference.

Alternately, you can select System Preferences = Quit System Preferences.

When choosing a background, you have a number of preinstalled options available. You can set
8 g y p p
your background as a solid color or as one of many stunning pictures or patterns.
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B To choose a color, click the Solid Colors list item and then choose one of the preselected
colors available in the right-hand window pane.

B To choose a picture, click any of the following list items:

Apple Images: This is a collection of swirled patterns. Typically these are attractive
patterns, usually comprised of a single color. Click any pattern in the right-hand frame
to set it as the desktop.

Nature: This is a standardized preselected list of nature-themed pictures. New images
include Aurora, Earth, Earth Horizon, Golden Palace, Rock Garden, Rocks, Zebra, and
Zen Garden. Click any picture in the right frame to set it as the desktop.

Plants: A collection of images of flowers and other vegetation. Grass Blades and Roses
are new to this collection.

Black and White: A collection of black-and-white landscape images. The Sea Mist
Blue and Wave images are nice additions.

Abstract: This is another collection of swirled patterns. These are typically much
more colorful, with two, three, or more colors per pattern. Click any picture in the
right frame to set it as the desktop.

Solid Colors: A collection of solid color backgrounds. Click any picture in the right
frame to set it as the desktop.

Pictures Folder: If your Pictures folder (located in your Home folder) contains any
images, they appear in the right-hand pane. Click any picture displayed in the right
frame to set it as the desktop.

iPhoto Albums: Linked to your iPhoto library, set your personal photos as your
desktop picture. Choose from Photos (all of the photos in your library), the Last 12
Months, the Last Import, and Flagged. Click any option and the results appear in the
right frame, allowing you to set a picture as the desktop theme.

Saving the Screen

Originally designed as a method of preserving displays from damage, screen savers are now

as much a form of entertainment as they are a hardware-protection measure. Early cathode ray
tube (CRT) displays were victimized by an unfortunate condition known as phosphor burn-in.
Phosphor burn-in occurs when a display shows the same image for too long. After a few days of
displaying the same static image, the display is permanently scarred with a shadow of the image.
That said, fundamental changes wrought in CRT display technology in the mid 1990s reduced the
risk of phosphor burn-in to practically nil. Phosphor burn-in is also no longer a concern for CRT
owners simply because lower prices and more demanding users result in the replacement of dis-
plays much more often. These factors combined to practically eliminate the need for screen savers.
A new factor has arisen though. Many users are migrating to liquid crystal displays (LCD), which
are again susceptible to a form of image burn-in. Screen savers are again a useful piece of software.
In general though, the best protection for your screen and your electric bill is to have your monitor
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completely switch off after a period of inactivity. This option is found in the Energy Saver prefer-
ence pane. (For more on the Energy Saver preference pane, see Chapter 17.)

To use a screen saver, or to change the settings of the currently selected screen saver, follow these
steps:

1. Click the System Preferences icon in the Dock (or choose Apple = System
Preferences). The System Preferences window appears, showing buttons for many differ-
ent settings. (Most are covered in Chapter 17.)

2. In System Preferences, click the Desktop & Screen Saver button or choose View &>
Desktop & Screen Saver. The System Preferences window changes to show one of the
two available panes in this preference panel. Screen saver controls are of course under the
Screen Saver pane. Click the Screen Saver button (top right) to reveal the Screen Saver
pane. Much like the Desktop pane, the Screen Saver pane is divided into two distinct
panels. The left side has a list of available screen savers; the right side shows a preview
display of the screen saver in action.

3. Choose the screen saver desired from the left panel.

Close the Desktop & Screen Saver preference pane with the Close button, or quit
system preferences via the Application menu to enable the screen saver.

The Screen Saver pane in System Preferences is shown in Figure 2.9. The standard preinstalled
screen savers are divided into two groups, Apple and Pictures. The Apple group includes the
following:

B Arabesque: This screen saver displays colorful dots that radiate in lines and random
alignments. After the light display is over, the dots seemingly explode into clouds of
evolving color. The clouds then condense and become focused colorful dots again,
forming an endless pattern of light and color.

B Computer Name: This screen saver is a simple display of a platinum-looking Apple logo
with an overlay of your computers name on a black background. The logo and name fade
and reappear, each centered at different points on-screen. Your computer’s name is set
during the installation process.

B Flurry: Although Flurry may or may not be the most popular, it is definitely the most
hypnotic! Flurry is perhaps best described as a single point of light erupting and spewing
forth colorful streams of light while moving around the screen. (You will buy Apple
computers . . . you will buy Apple computers . . .)

B iTunes Artwork: Some MP3 files have embedded album or artist artwork. This screen
saver cycles through that artwork in a slide show.

B RSS Visualizer: Your computer can pull down headline news and topics, and display the
headlines in columns of text that fly by. This screen saver also offers an interactive oppor-
tunity to “read more” by pressing a key.

B Shell: This screen saver is a lovely display of floating streams of color that form different
shapes. This screen saver is similar to the iTunes visualizer.

33



Getting to Know Mac OS X

34

Spectrum: Various colors cycle through the spectrum. (It’s like the end of the movie
2001: A Space Odyssey, although it makes more sense.)

Word of the Day: This screen saver is a simple display of a word and its definition. A
new word appears approximately every three minutes. The screen saver also offers an
interactive opportunity to “learn more” about the word shown by pressing the D key.

The Pictures group includes the following:

.Mac and RSS: This screen saver allows you to access and display images from your .Mac
account, as well as any public images from your friends’ or family’s .Mac accounts. It also
displays any RSS feeds you subscribe to with your .Mac account. If no .Mac account is
available, the slide show displays various Apple marketing images.

Abstract: This is a collection of colorful patterns and swirls, cross-fading and panning
across the screen. This is the first of the Ken Burns-style slide show screen savers. (Ken
Burns directed a series of famous documentaries and is very creative in the use of still
images that pan, fade, and zoom throughout.)

Beach: This is another of the slide show-style screen savers. Rather than abstract images
of color swirls, Beach is comprised of photos of various beach locations. Consider it
inspiration for your next vacation.

Cosmos: Like the Beach screen saver, but probably designed by a Star Trek fan, Cosmos is
comprised of various deep space photos.

Forest: Another of the slide show-style screen savers, Forest is a collection of images of
various wilderness locations. (Queue your favorite Enya tracks while it plays.)

Nature Patterns: This is another slide show of a collection of zoomed-in and almost
microscopic images of nature, like the patterns of a snowflake. Mac OS 10.5 brings a
number of new, stunning images to this collection.

Paper Shadow: A collection of images of paper, forming delicate curves and shadows,
like an origami party gone wild.

Pictures Folder: Any images stored in your Pictures folder (located in your Home folder)
become the slides in this screen saver slide show as they pan, zoom, cross-fade, and ran-
domize. (Moving items to and from folders is discussed in detail in Chapter 5.)

Choose Folder: Just as with the Choose Folder option for the Desktop Picture, by select-
ing this option, a dialog box opens. Choose a folder containing images you want to have
as a screen saver. Click Open when you find the folder, and the dialog box closes. The
screen saver displays images from the selected folder.

Photos: A tie-in to iPhoto, this screen saver option uses your entire iPhoto library as the
slides in the screen saver.

Last 12 Months: This option displays images that have been imported only in the last
12 months as the available elements of the slide show.

Last Import: This option uses images only from your last iPhoto import as the available
elements of the slide show.

Flagged: This option displays only the pictures that have been flagged in iPhoto.
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FIGURE 2.9

Screen savers engage after a set period of inactivity, replacing your screen’s displayed
items by showing photos, cycling interesting patterns, or changing colors.
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Optimizing screen saver settings

In addition to selecting a screen saver, there are a few settings available to optimize each screen
saver’s functionality.

B Test: Click the Test button under the preview area of the screen saver pane to preview
your screen saver in full-screen mode. Move the mouse or click any key to return to the
preference pane.

B Start Screen Saver: This slider, located at the bottom of the Desktop & Screen Saver
window, allows you to set the screen saver’s activation time. The activation time is how
long the computer will sit idle before engaging the screen saver. The slider ranges from
two minutes to two hours, with Never at the far right. Setting activation to Never prevents
any screen saver from engaging automatically.

B Random: If you click the Use random screen saver check box in the lower-left area of the
pane, Mac OS X chooses a random screen saver to activate.

B Clock: Ever wish that the time appeared while the screen saver was activated? Apple has
added this capability to their screen savers. Selecting this check box displays a digital
clock while your screen saver is engaged. What's especially cool is that when the screen
saver is first activated, the clock counts down the seconds until the screen is locked
(assuming this setting has also been turned on).

B Hot Corners: When clicking this push button in the lower left corner, a dialog box
appears. In the dialog box, four pop-up menus in the corners surround a small window
displaying a thumbnail image of the desktop. Clicking any of these menus reveals options
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that engage when a user moves the mouse to that corner of the screen. The options
include Activate Screen Saver, Disable Screen Saver, and any of the three modes of
Exposé. You can assign each corner one of these commands. Moving the pointer to the
specified corner initiates that action. Activate Screen Saver immediately engages the
screen saver. Disable Screen Saver prevents the screen saver from engaging at the speci-
fied activation time. The Exposé features are covered in the “Exposing Exposé” section
later in this chapter. Figure 2.10 shows the Hot Corners dialog box, as well as one of the
pop-up menu’s options.

FIGURE 2.10

The Hot Corners dialog box not only enables you to activate screen savers, but also
allows you to set Exposé options.
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Setting screen saver options

Each screen saver may have a series of options available to modify its performance. When you
select a screen saver on the left side of the Desktop & Screen Saver dialog box, click the Options
button that sits underneath the preview. If the Options button is dimmed out, there are no avail-
able options. (For example, the Computer Name screen saver has no available options.)

Making its first appearance in Mac OS 10.5, the Display Style setting puts a new spin on the dis-
play of your Picture screen saver images. You can choose from the following styles:

Standard: Presents images in the standard display. In this very simple display, images
take up the entire screen.

Photo Prints: This setting presents each image as a printed photo being dropped onto a
surface. Options for this style include viewing images in Classic mode, with a thin white
border, or Annotated, with a Polaroid-like border. If you select the Annotated layout, you
can also choose to show the image name and the date, as depicted in Figure 2.11.

Mosaic Tile: By far the most artistic of the new display style options, this setting works
with your iPhoto library to generate a mosaic of every screen saver picture. It begins by
displaying a screen saver image and then pulling outward slowly to reveal a custom
mosaic created using your photos.
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FIGURE 2.11

The Photo Print style is a cool, new way to display screen saver images.

Preview

| [ s B | ( oprions J‘; ( Test )

Display Style

Flurry’s options include the following:

B Color: This pull-down menu contains many options. There are six colors to choose from
(each of which roots the Flurry’s eruptions in a particular color space); there are four
cycle speeds (each sets the Flurry’s eruptions to cycle through all colors at varying speeds);
and finally, there are three brightness levels to choose from (each keeps the Flurry and its
eruptions rooted at a particular degree of brightness). These options are mutually exclu-
sive. The Flurry is set by default to Cycle and an average brightness setting, and to cycle
through all colors.

B Streams: A slider ranging from Few to Many, Streams sets how many eruptions of color
come from the Flurry. By default, this is set in the middle.

B Thickness: A slider ranging from Thin to Thick, Thickness sets the width of the emerging
streams of color. By default, this is set in the middle.

B Speed: Another slider, ranging from Slow to Fast, Speed sets the pace at which the Flurry
itself moves about the screen. By default, this is set in the middle.
iTunes Artwork options include the following:
B Rows: Using the slider, select how many rows of artwork you want to appear. You can
choose as little as two or as many as eight rows.

B Delay: A slider ranging from 0 to 5 controls how many seconds elapse between each image.
RSS Visualizer options include the following:

B Select an RSS feed or enter one below: Choose from the Apple-provided RSS feed, or
supply your own. To change the feed, enter the URL of the feed you want to subscribe to
in the Feed URL field.

B Article Display Duration: A slider ranging from 0 to 11 controls how many seconds
elapse between each article.
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Word of the Day includes the following option:

B Dictionary to Use: Choose from Apple’s dictionary, or the New Oxford American
Dictionary.

All of the slide show-style screen savers have the same options set, with check boxes to engage/
disengage each option. The options include the following:

B Present slides in random order: This option randomly presents the images from
the available slides. In the case of large image collections, this option helps to alleviate
boredom. (After all, screen savers are supposed to be fun!)

B Cross-Fade between slides: This option enables the selected slides to cross-fade from
one to the next; as one image fades away, another fades in.

B Zoom Back and Forth: This option causes the screen saver to zoom in and out on
images, as well as to pan left and right.

B Crop to Fit on Screen: This option ensures that your images appear full screen, as
opposed to appearing too small or radically oversized.

B Keep Slides Centered: This option modifies the Zoom Back and Forth option, so the
slides zoom in and out only, and no longer move left to right. Having Zoom Back and
Forth and Centered Onscreen unchecked disables all zooming and panning, and results
in a more static (boring) screen saver.

B Screen savers are also a very convenient way to secure your workstation if you walk
% away and forget to log out, because you can set the screen saver to lock down your
workstation in the Security preference pane.

Peeking into Windows

A window is literally a portal that displays content for your perusal. There are many different kinds
of windows. Each serves a particular function; each offers options for control and interaction.
Some windows show the contents of disks and folders. Some windows show the text of a written
document or the content of a photograph. Certain windows alert you to conditions requiring your
attention. Other windows even offer interaction with tools that are used to modify the contents of
other windows (whew!). Most windows are rectangular and malleable. You can reshape them to
maximize your screen real estate. This section describes how different types of Mac OS windows
look and operate.

Recognizing different window types

There are several types of Mac OS X windows, and each is designed to display a specific kind
of information. Some windows display the files and other items stored on disks. Other window
types display the actual contents of files, which may be text, pictures, movies, or other kinds of
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information. Figure 2.12 shows examples of the different types of Aqua windows. The different

types of windows are as follows:

B Windows: Windows show any nonstandard data, ranging from a document written in
Microsoft Word, to a QuickTime movie or a video game (even when a game is running
“full screen,” it is still technically a window). Another type of window is the Finder win-
dow, which shows the content of folders and disks. These windows are generated by the
Finder, which is covered in further detail later in this chapter.

B Dialog boxes: These are windows that display options that require an action before you

can continue.

B Sheets: Sheets are dialog boxes that apply to, and are attached to, another window. A
sheet ensures you won't lose track of which window the dialog box applies to.

B Palettes: Also called panels or utility windows, palettes contain controls or tools, or dis-
play auxiliary information for the application that you’re currently using.

FIGURE 2.12

The Mac OS X Aqua environment has several different types of windows: a document (a), a dialog box (b),

a sheet (c), and a palette (d).
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Window controls

As mentioned earlier in this chapter, windows are portals that display important data. They are made
up of numerous control surfaces and other objects, including buttons and more. There are many
different types of windows in Mac OS X, as discussed later in this chapter, but there are a slew of
common control surfaces and buttons available within most windows. Of course, you won't find all
types of window controls on every kind of window. For example, document windows have all or
most of the available controls, whereas dialog boxes generally have fewer window controls avail-
able, and alerts have fewer still. Figure 2.13 shows a standard document window with the most
commonly found items indicated.

40

Title bar: The title bar is usually the home of the stoplight cluster of close (red), mini-
mize (yellow), and expand (green) on the left side, as well as the location of the name of
the active window (the title). The title indicates which document is currently being shown
(or which folder is being shown in the case of a Finder window, which is discussed later
in this chapter). Click and drag the title bar to move the window. Double-clicking the
title bar minimizes the window into the Dock just as the Minimize button does.

Close: The Close button is the uppermost and leftmost item in every window. Typically a
round red button found at the top left of a window, when you position the pointer near
the Close button, an X appears in its center. This button closes the window to which it is
attached. In some applications, notably the Finder, press the Option key and click this
button to close all of the application’s windows. Please note that unlike Microsoft Windows,
this will not usually quit the active application, but simply closes the displayed window.
Quitting applications is covered in Chapter 5.

Minimize: The Minimize button is usually a round yellow button, found to the right of
the Close button, that displays a minus sign (=) when you position the pointer near it.
Clicking this button minimizes the attached window, sucking it down into the Dock, for
easy retrieval later. Be warned: Minimizing too many windows results in a cluttered Dock!

Zoom: The Zoom button is typically a round green button, found to the right of the
Minimize button, that displays a plus sign (+) when you position the mouse pointer near
it. Its function is first to make a window as large as is required to display all items within,
or to make that window as large as possible, without stretching off-screen if too many
items are present to be displayed at once. A zoomed window may leave a margin at the
bottom or sides of the screen for the Dock. After the first zoom-button click, this button
then reduces the window to its original size. If a window cannot be resized, its zoom but-
ton is dim, and a plus sign does not appear in its center.

Scroller: The scroller is both an indicator as well as a control item. The scroller indicates
a given window’ current focused position of the displayed folder contents with both its
size as well as its position in the scroll bar. For example, if the scroller is at the top of the
scroll bar and is taking up about one third of the bar, the window is displaying one third
of the total folder’s viewable material, and is showing the top third portion. Click and
drag the scroller to move quickly to a desired position within a displayed folder. A scroller
can appear on the right of a folder or window as well as at the bottom. This is the fastest
way to shift your window? list of displayed items. Like scroll arrows, the scroller is not
available if all of a folder’s contents are displayed by the current window’s size.
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W Scroll Bar: The scroll bar serves as a container for the scroller. The scroll track can be
clicked to refocus the window one full window display area at a time. For example, if the
scroller is half the size of the scroll bar and at the top of the scroll bar, a single click in the
scroll bar moves the window’s focus to the bottom half. This method is useful to quickly
scan a folder’s contents.

B Scroll arrow: The scroll arrows shift a window’s focus in the arrow’s indicated direction
slightly with each mouse click. Clicking and holding on a scroll arrow shifts the window’s
focus both smoothly and more quickly. These buttons are useful when trying to slowly
scan through a large grouping of items.

B Resize control: The bottom right corner of a window is typically the control for resizing
the window. This is usually indicated with a slightly rougher texture or three lines in the
corner that would suggest grabbing it. Click and drag the resize corner to adjust the size
of the window.

FIGURE 2.13

Windows are made up of numerous controls and objects. Learning what they all do is crucial to an effi-
cient computing experience. The items highlighted are common to many windows.
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Buttons and other controls

Window controls, as covered in the previous section, afford you the means for controlling the win-
dow itself. However, many of the windows encountered day to day contain a wide variety of con-
trols that you also operate by clicking or dragging with the mouse. These other controls perform
various functions, hopefully clearly labeled by the software designers! Examples of these other
controls include push buttons, check boxes, radio buttons, sliders, little arrows for increasing or
decreasing numeric values, disclosure triangles, scrolling lists, and tabs.

Using push buttons

A push button causes an action to take place when clicked. A label on the button indicates the action
that the button performs. The label may be text or graphic. Push buttons with text labels are gener-
ally rectangular with rounded ends. Buttons with graphic labels may be any shape. An example of
push buttons is illustrated in Figure 2.14.

Using standard OK and Cancel buttons

Many dialog boxes and alert windows have buttons labeled OK and Cancel. Clicking OK accepts
all the settings and entries in the dialog box (or the conditions stated by the alert). Clicking Cancel
rejects any changes you may have made in the dialog box and restores all settings and entries to
their state before the dialog box appeared, or cancels an action. A shortcut for clicking the Cancel
button is pressing the Escape key (the Escape key is labeled esc) or pressing the 8 and period (.)
keys in combination.

Using radio buttons

Radio buttons are one way to select a single setting from a group. They're called radio buttons because
they work like the station presets on a car radio. Just as you can select only one radio station at a
time, you can select only one radio button from a group. To select a radio button, click it. The
selected radio button is darker than its unselected neighbors. Radio buttons are shown in Figure 2.15.

FIGURE 2.14

Click a push button in an Aqua window to cause an action to take place.
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FIGURE 2.15

Click a radio button in an Aqua window to select one setting from a group.
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Using check boxes

A check box is another way to select a setting from a group or turn a setting on or off. When a setting
is on (or selected), a check mark appears in the check box. When a setting is off (or deselected),
the check box is empty. When a setting is partly on and partly off because it indicates the state of
more than one thing, such as the format of a range of text, a dash appears in the check box. Unlike
radio buttons, check boxes are not mutually exclusive. You can turn on check boxes in any combi-
nation. That being said, some applications may use check symbols in their radio button fields,
allowing only one check to be seen at a time, just to confuse us all. Be careful. Clicking a check
box reverses its state. Figure 2.16 shows check boxes.

Using sliders

A slider consists of a track that displays a range of values or magnitudes and the slider itself, also
known as the thumb, which indicates the current setting. You can change the setting by dragging
the slider. An Aqua slider is a dark color (initially blue, but you can change colors as described
later in this chapter). Sliders are shown in Figure 2.17.

FIGURE 2.16

Click check boxes in Aqua windows to turn individual settings on and off.
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FIGURE 2.17

Drag a slider in an Aqua window to change a setting across a range of values.
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Using little arrows

Little arrows that point in opposite directions let you raise or lower a value incrementally. Clicking
an arrow changes the value one increment at a time. Pressing an arrow continuously changes the
value until it reaches the end of its range.

Using disclosure triangles

A disclosure triangle controls how much detail you see in a window. When the window is displaying
minimal detail, clicking a disclosure triangle reveals additional detail and may automatically enlarge

the window to accommodate it. Clicking the same triangle again hides detail and may automatically
shrink the window to fit. Figure 2.18 shows an example of disclosure triangles.
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Click a disclosure triangle to adjust the amount of detail shown.
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Using scrolling lists

A scrolling list displays a list of values in a box with an adjacent scroll bar. If there are more values
than can be displayed at once, the scroll bar becomes active and you can use it to see other values
in the list. Clicking a listed item selects it. You may be able to select multiple items by pressing
Shift or 8 while clicking. See Figure 2.19.

FIGURE 2.19

Scroll a list to see an item you want and then click to select it (Shift+click or 8+click to select multiple
items) in an Aqua window.
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Using tabs

Tabs in Mac OS windows perform the same function as tabs on dividers used in card files or ring
binders. They divide the contents of a window into discrete pages or sections, with each tab pre-
senting one section of window content. Apple calls each tabbed section a pane. You can see only
one pane at a time, and users switch to a different pane by clicking the appropriate tab. Figure 2.20
provides two examples of tabs.

FIGURE 2.20

Tabs come in many shapes and sizes.
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Working with Windows

Having described windows in detail, its important to remember that there are many additional
types of windows in Mac OS X, but they all adhere to standards of command and have many of the
same control surfaces. In this section, you learn how to create and control windows. You work
mostly with Finder windows because they tend to have the most tools for control.

New window, please

As noted earlier in this chapter, to open an item in a new window (like a folder or document),
simply double-click the item. Alternately, you can single-click to select a folder or disk and then
press 88+0 or choose Open from the File menu (or use any of the other options presented). To
open a new Finder window that displays your Home folder, click on the desktop and press
B+N.

Active and inactive windows

When more than one standard window is open, only one window is considered active, meaning
that you can interact with all the items in it, and control the surfaces it is comprised of. You may be
able to interact with some window controls and other items in inactive windows (for example, you
can close inactive windows by clicking their respective Close buttons), but you can’t interact with
everything in inactive windows.
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Recognizing the active window

You can recognize the active window because it is in front of all inactive windows. Therefore,

the active window overlaps all other windows except palettes belonging to the same application
as the active window. (Palettes float in a layer above the active window.) In addition, the active
window is conspicuous because all of its controls are full color and available for use, whereas the
controls of inactive windows appear grayed out as shown in Figure 2.21.

FIGURE 2.21

The active window is in front of inactive windows, and controls and items in the inactive window appear

grayed out.
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Making another window active

You can make any window the active window by clicking any visible part of it, with the exception
of the close or minimize buttons. Making a window active brings it to the forefront; if the new
active window belongs to an application with palettes, they also come to the front. To make all the
windows of a Mac OS X application come forward together, click the application’ icon in the Dock.

If an alert or a dialog box other than a sheet appears, you may need to dismiss it (by
clicking its OK button or Cancel button) before you can make another window active in

the same application program.

Interacting with inactive windows

If you want to interact with something in an inactive window, you can always click the window to
make it active and then click again to interact with the object of your desire in the window. In some
cases, you don't have to click twice to interact with items in an inactive window. For example, you
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can operate the Close, Minimize, and Zoom buttons in most inactive Aqua windows, and they per-
form their standard functions, closing, minimizing, or in the case of Zoom, changing the window’s
size. In addition, some applications bring a window to the front when you click the window’s Zoom
button. The Finder does not behave this way; a Finder window that’ in the background stays in
the background when you click the window’s Zoom button, but the window resizes. If you think
about what the Close and Minimize buttons do, you can see why clicking one of these in an inac-
tive window does not bring the window to the front. The ability to interact directly with an item in
an inactive window is called click-through.

Some items in inactive Aqua windows respond when you interact with them, and other items in
the same windows don't respond. A responsive window control in an inactive Aqua window
becomes more pronounced when the mouse pointer passes over it. A responsive item labeled with
text or a symbol (such as an arrow) is supposed to have a dark label to indicate that it is enabled.
An unresponsive item is supposed to have a dim label to indicate that it is disabled. However, Mac
OS X applications don't follow these rules uniformly. You have to learn by trial and error which
items are responsive in inactive windows.

Using the Window menu

When you have multiple Finder windows displayed and want to use one in particular, figuring out
which of them is the one you want can often be difficult. In Mac OS X, the Finder exhibits a
Window menu that lists all the open Finder windows by name; active windows are indicated with
a check to the right of the item’s title. You can quickly bring a particular Finder window to the front
by choosing it from the Window menu. Figure 2.22 shows an example of the Finders Window
menu. You can also flip through the windows by using the 38+~ (tilde) shortcut.

In Mac OS X, Finder windows can become intermingled with windows belonging to other applica-
tions. Clicking a window belonging to a particular Mac OS X application brings just that one win-
dow to the front. If you click Finder windows alternately with windows belonging to other Mac OS
X applications, the windows end up stacked in the order you clicked them regardless of the appli-
cation, as shown in Figure 2.23.

FIGURE 2.22

Bring a Finder window to the front by choosing it from the Window menu.
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Finder windows can become intermingled with windows belonging to other Mac OS X applications.
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Bringing just the clicked window forward is a consistent and flexible behavior, but there are times
when you may want to bring all of a particular application’s windows forward. This is the raison
d’étre of the Bring All to Front command in the Window menu. Choosing Window = Bring All

to Front moves all the Finder windows in front of all other applications’ windows, while retaining
their own front-to-back ordering. Choosing Window = Bring All to Front does not bring any mini-
mized windows to the front; they remain in the Dock. Let us hope that developers of other Mac
OS X applications follow the Finder’s lead, and build this function into all applications. Many
already have it, but some don't. Heck, some applications don’t even have a Window menu yet!

Window Tricks

ou can move and minimize most inactive windows without bringing them to the front. The fol-
lowing window tricks work even on windows that don’t have visible controls:

B To move an inactive window, press 38 while dragging the window’s title bar or frame.

B To minimize, close, or zoom all windows that belong to the same application as the
active window, press 8+Option while clicking the active window’s Minimize, Close, or
Zoom button. In some cases, you get the same effect on inactive windows by pressing
Option+8 while clicking the appropriate button.
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You can also bring all the Finder’s windows to the front by clicking the Finder’s icon in
- the Dock. To bring all Finder windows to the front while hiding all other windows,
3€+Opt|0n+cllck the Finder’s icon in the Dock.

Worshipping Icons

Now that menus and windows have been discussed, there’s one key piece of the puzzle left. Icons!
Icons are small pictures that represent many objects in the Mac OS. You work with the objects by
manipulating their respective icons. For example, you work with the applications, documents,
folders, and disks in your computer by manipulating icons on the computer screen. This section
explains how to identify the different types of icons by their appearance, and most important, how
to use icons.

The icons in Mac OS 10.5 have a very different look from the icons in previous Mac OS versions.
Figure 2.24 illustrates the new Finder icons. They are typically larger and much more photorealis-
tic. Unlike the fixed-size icons in previous Mac OS versions, you can size Mac OS X icons up to
128 x 128 pixels. In some contexts, you decide how large you want Mac OS X to display icons. In
other contexts, Mac OS X scales icons to fit the available space.

An icon’s basic appearance often gives you some idea of what kind of item it represents. You can
usually identify icons for applications, documents, and folders by common characteristics of
each type.

FIGURE 2.24

In Mac OS 10.5, the folder icons look decidedly different.
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Identifying application icons
Application icons come in two basic varieties:

B Mac OS X applications: Icons of Mac OS X applications have several distinctive charac-
teristics. An application icon depicts the kind of information it creates or views, such as
pictures, notes, or a particular type of document. Application icons usually include a tool
that suggests the type of task the application helps you perform, such as a stamp for
e-mails or a musical note for music.

B Mac OS X utilities: The icon of a utility application communicates the auxiliary function
it performs. An icon showing a doctor’s stethoscope over a hard drive suggests a utility
that checks the vital signs of a hard drive, and in fact is the icon for Apple’s Disk Utility.
Figure 2.25 provides examples of Mac OS X utility icons.

FIGURE 2.25

Like application icons, utility icons generally advertise their function.
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Identifying document icons

In Mac OS 10.5 document icons look like a sheet of paper with a preview of the data (text, image,
movie, and so on), a dog-eared corner, and the file extension (of the application that created it) in
the bottom half of the icon. Document files can contain text, pictures, sounds, and other kinds of
data stored on your computer.

Identifying folder icons

Icons that look like manila folders represent the folders in which programs, documents, and other
items are organized on your disks. A folder with a special purpose may incorporate an image that
indicates the particular kind of items the folder contains.

Identifying volume icons

Volume icons are pretty easy to spot; they usually look like the type of volume they are. For exam-
ple, hard drives look like real hard drives, and CD-ROMs look like actual CDs. Network drives
may be depicted with a distinctive starscape sphere, or may appear as hard drives with wires
emerging from the bottom, symbolizing the network connection to the drive. See Figure 2.26.
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icons represent the type of volume mounted.
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FIGURE 2.27

Identifying alias icons

Aliases are shortcuts to a document, folder, or application. These original items often reside deep
inside a hard drive, or even on a server drive. By using aliases, users can navigate to desired loca-
tions quickly, with less clicking (aliases are discussed in forthcoming sections of this chapter). The
alias icon is typically a copy of the original item’s icon, with a small black arrow in the lower left
corner, indicating the icon “points” to an original item.

Identifying restricted folders

Some folders on your computer or on servers you connect to are restricted to particular users. This
is particularly true of items within other users’ home folders (covered later in this chapter). You
cannot access and edit another user’s folders or their contents when logged in with your account.
You can spot restricted folders easily because they are marked with the “do not enter” symbol, a
red circle with a white dash. Figure 2.27 shows an inactive user’s home folder and all of its
restricted folders.

These restricted folders are inaccessible to the current user. This is a view of another user’s home folder.

Notice that the Public and Sites folders are not restricted.
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FIGURE 2.28

Interacting with icons

Whether you are viewing your windows in list view, column view, or icon view, the items you
interact with day to day are icons. All icons respond universally to a few standard interactive tech-
niques. This section explores some of them, preparing you for a more in-depth look at your envi-
ronment in the following chapters. Opening applications and creating/editing documents is
covered in Chapter 5.

Selecting icons

Everyone who uses a Mac quickly learns to select an icon by simply clicking it with the mouse, but
even some seasoned veterans don’t know that you can select icons individually by typing instead of
clicking. In addition, you can select more than one icon at a time using various techniques.

When you select an icon, the Mac OS highlights it by creating a border around it and by highlight-
ing the item’s name. Figure 2.28 shows an example of an icon that is highlighted and one that isn'.

Mac OS X highlights the selected icon by surrounding it with a more distinct shadow and highlighting

the title.
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Selecting multiple icons by clicking

Ordinarily, clicking an icon selects it (highlights it) and deselects the icon that was previously
selected. After selecting the first icon, you can select a group of icons in the same window by
pressing and holding the 8 key while clicking each icon in turn. At any time, you can deselect
a selected icon by pressing and holding the 3 key and clicking it again.

Selecting multiple items in a column view

In a window where icons appear in a list or column, you can select a whole range of icons with
two clicks. First, you click one icon to select it, and then you press and hold the Shift key while
clicking another icon to select it and all the icons between the first icon and the one you just
selected. You can also select individual items by pressing and holding the 38 key while clicking an
icon. In a column view, when multiple items are selected, preview data in the rightmost column is
not shown, nor do selected folders expand in the next column.
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Selecting from multiple folders in a list view

In a list view, 3+clicking affords you an additional technique for selecting. After expanding several
folders in a list view, you can simultaneously select items in any of the expanded folders. To select
an additional item, press 3 while clicking it. If you want to select consecutive items, Shift+click
the first and last item. If you need to deselect a few items, 3+click each item. Figure 2.29 shows a
list view with items selected from two folders.

Selected items remain selected if you expand or close other folders in the same window. Note that
any selected items in a folder you collapse are no longer selected.

FIGURE 2.29

In a list view, you can select items from multiple folders.
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Selecting multiple icons by dragging

In addition to selecting multiple icons by clicking with the 3 or Shift keys, you can select adjacent
icons by dragging the mouse pointer across them. As you drag, the Mac OS displays a shaded rec-

tangle, called a selection rectangle, and every icon it touches or encloses is selected. Icons are high-
lighted one by one as you drag over them, not en masse after you stop dragging. All icons must be

in a single window.

You can combine dragging with the use of the 3 key. Pressing 8 while dragging a selection rectan-
gle across unselected icons adds the enclosed icons to the current selection. Conversely, pressing 36
while dragging a selection rectangle across selected icons deselects the enclosed group without des-
electing other icons (if any).

Selecting by typing
When you know the name of an icon that you want to select but aren’t sure where it is in a win-

dow, you can quickly select it by typing. Typing may be faster than clicking if the icon you want to
select requires lots of scrolling to bring it into view.
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TABLE 2.1

To select an icon in the active window simply type the first part of its name. You need to type only
enough of the name to identify the icon you want uniquely. In a window in which every icon has a
completely different name, for example, you need to type only the first letter of a name to select an
icon. By contrast, in a folder where every item name begins with New, you have to type those three
letters plus enough additional letters to single out the icon you want. This typing must be done
reasonably quickly, because any lengthy delays result in the computer assuming you are searching

for a new file. This may frustrate slower typists. Also, pressing one of the arrow keys selects the
icon nearest the one currently selected in the arrow’ direction. In a window where icons do not
appear in a list, pressing Tab selects the next icon alphabetically and Shift+Tab selects the previous
icon alphabetically. Table 2.1 summarizes keyboard selection techniques.

Selecting Icons by Typing

To Select This Do This

An icon Type the icon’s partial or full name
Next icon up or down Press Up (T) or Down Arrow ({)
Next icon left or right” Press Left (<) or Right Arrow (=)
Next icon alphabetically” Press Tab

Previous icon alphabetically” Press Shift+Tab

“Applies only to a window where icons are not displayed in a list.
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Contextual Menus

y simply Control+clicking an item, the contextual menu is revealed. Each item’s contextual

menu is different, depending on the item’s type (thus the name, contextual). Folders, documents,
aliases, disks, and applications all get their own set of options. All the commands made available in
a contextual menu are available elsewhere, via the File menu, the Apple menu, or some other way,
but the contextual menu is a convenient and quick way to apply commonly used commands to an
item. Opening the contextual menu for the desktop and selecting Change Desktop Background
opens the Desktop & Screen saver preference pane, which enables you to change the desktop back-
ground. The contextual menu for a standard document has an Open With option. This expands via a
submenu to show compatible applications. It’s a convenient way to open a document with a differ-
ent application; it is especially fast when using a two-button mouse. We refer to contextual menus
often, and strongly recommend purchasing a two-button mouse and using the right-button. The two-
button method is much easier and faster than the Control+click method.
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Moving icons

After selecting a few items, you may want to move them around. To move files from folder to
folder, simply select the files, and then drag any of the items to the new desired location. You can
drag an item by its icon or its name. In a list view, you can also drag an item by any text on the
same line as the item’ icon, such as its modification date or kind. The new location for your item
can be the desktop, an open Finder window, or a closed folder. When you position the item you
are moving over a folder icon, the Finder highlights the destination icon by making it darker.
When you drag an item over a Finder window, the Finder highlights the window by drawing a
heavy border inside the window frame. The highlight visually confirms your target.

When you release the mouse button, the item is moved from its original location to the newly
selected one. There is one exception: If you are attempting to move a file to a different volume, the
mouse pointer changes from a black arrow to a plus sign within a green dot. This symbol signifies
that you are not moving the file to the new location, but rather making a copy of the file in the new
location. The original item remains unaffected. You can force the file to move by holding down the
38 key while dragging the file to the volume.

Replacing items

If you move an item into a folder that contains another item of the same name, you are confronted
with an alert, asking if you want to replace the file at the destination. (If you copy a group of items
and more than one of them has the same name as items at the destination, you are alerted one by
one for each of the duplicates.) Clicking Replace erases the items noted in the alert window from
the destination folder and replaces them with the moved items. Clicking Stop cancels the opera-
tion, while clicking Don't Replace stops the file in question from being moved. You may also have
the option to apply the action to all of the items you are moving, by selecting the Apply to All
check box as seen in Figure 2.30.

FIGURE 2.30

You get this message when attempting to move an item to a folder where a file with that name already exists.

[Fa ae’ Copy.

An item named “Picture 17 with extension “.png” already
a exists in this location. Du you want o replace it with the one
you're moving?

[ Apply to all ( Don'tReplace ) [ Stop ) [ Replace )

Spring loaded folders

To move an item from one folder to another, you do not need to have both folders open in separate
windows simultaneously. You can deposit an item directly on top of another folder. This places the
item within the folder. If you want to delve deeper, use Apple’s extra-nifty Spring Loaded Folders

55



Getting to Know Mac OS X

56

Making Corrections with Undo

f you move a file to an incorrect location, assign the wrong file name, or incorrectly label a file with a

color, pressing 8+Z (or selecting Undo from the Edit menu) undoes the erroneous move/name/color.
The function undoes only the last action performed, and the Undo operation does not undo an item
replacement or deletion. It simply restores items to their original location or name or color, but replaced
or deleted items are gone for good! Of course, it’s still a powerful tool to use. In fact, after using the
Finder’s Undo feature a few times, we all wish the other aspects of our lives had an “undo.”

feature. Drag an item over a folder to highlight it and hold it there. After a brief delay, the folder
blinks twice as if double-clicked and opens to display its contents. A new window opens if there
wasn't a window opened already. You can then place the item within the folder that has been
sprung, or repeat the process until you reach the folder you were seeking. If you open the wrong
folder with this method, either move the item out of the window (which closes the window), or

move the item over a location in the sidebar to navigate there. For example, if you delve too deeply

into your Documents folder, go back to the root level of the folder by dragging over its icon in the
sidebar. After the brief Spring Loaded Folder delay, your window now displays the Documents
folder, and you can reattempt the moving process. After you release the item into its new location,
the item is placed there. It is worth noting that if the window was created by the Spring Loaded
Folders feature, releasing the item places it in its new location and also closes the window.

This technique works for disks as well; dragging an item directly on top of a disk opens a new
Finder window displaying the contents of the root level of the selected drive. Pressing the space

bar while dragging an item on top of a folder or disk will open it into a Finder window. The length

of delay time before springing is set in the Finder Preferences window, which is covered in later
sections of this chapter.

Replicating your files

There will be times when you may need to replicate a file, either to make changes to one while pre-

serving the original version, or to copy the file from one disk to another. The commands Copy or

Duplicate are typically used, and are interchangeable in this context for all intents and purposes. In

either case, there are a few simple techniques available.

Duplicating an item

To generate an identical copy of a selected item in the same location as the original, use the
Duplicate command. To perform a duplicate operation, single-click an item and select Duplicate
from the File menu. If the item chosen is a folder, the duplicate contains duplicates of everything

stored in the original folder. The newly created item is placed in the same folder as the original, but
with the word copy tagged onto the end of its name. This phrase is added to the end to help distin-

guish between the original and the copy, and because two files with the same name cannot exist
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simultaneously in the same folder. Additional copies of the same item also have a serial number
added after the word copy. If the name does have a file extension, the word copy and the serial
number appear before the extension. For example, the first duplicate of a folder named Untitled
Folder is Untitled Folder copy, but the first duplicate of a file named Readme.txt is Readme
copy.txt, and the second duplicate of the file is Readme copy 2.txt. The keyboard shortcut for
Duplicate is 8+D. You can also duplicate a file with the contextual menu, selecting the Duplicate
option when Control+clicking an item.

Copying an item

The main difference between Duplicate and Copy is that Duplicate creates the new item in the same
location as the original and tinkers with the new item’s name, whereas Copy does not. A copy can
create items in the same folder, forcing the name change, but it can also create files in new locations,
with no need to change the name, due to the alternative location (that is, no name conflict).

To copy a file, select the item and then choose Copy from the Edit menu (or contextual menu).
Then, navigate to the new desired location and make it active. Select Paste from the Edit menu to
initiate the copy. This method works best with a two-button mouse, because all copies can be done
with one hand.

Another method is to press and hold the Option key and then drag the file. The pointer switches
from its normal status as an arrow to a plus symbol in a green dot. This signifies that you are about
to copy the file to the selected location, rather than just move it there.

The Finder always copies an item when you drag it to a folder that’s on another disk. Again, the
Finder displays a green plus sign on the pointer when you position an item over a folder of a dif-
ferent disk.

Replacing an item

As with moving files, when you copy an item to a folder that already contains an item by the same
name, an alert asks whether you want to replace the item at the destination. If you copy a group of
items and more than one of them has the same name as items at the destination, you are alerted
one by one for each of the duplicates. Clicking Replace erases the items in the destination folder
and replaces them with the new copies. Clicking Stop halts the copy operation.

Renaming files

After an item is selected, you can rename the item to better reflect your needs. For example, you
may need to reflect changes in the document by tacking on revised to the name, or you may just
want to rename an item to reflect its creator or content: “Letter from Chantel” or “Zanetta’s Birthday
Invite.” Some items can be renamed with impunity, and other items are best left unmodified.
Documents can be renamed with total freedom. However, applications and system files should not
be renamed. Disks can be renamed with freedom, although the new name may goof up some exter-
nal things, like aliases and path shortcuts. (Aliases are covered in detail later in this chapter; net-
work paths are covered in Chapter 11.)
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Creating an Archive

rchive creation is a standard feature in Leopard. This was once handled by third-party software,

but Mac OS has built in this functionality. What is archiving? Archiving compiles and com-
presses any number of files selected into a single, smaller, more protected file. Select any folder,
disk, item (or group of items), and select Create Archive of <filename> from the File menu (or from
the contextual menu). When using the archive command, a progress bar briefly appears as the sys-
tem is creating the archive. Archiving is often necessary to e-mail files to friends because e-mail
really kicks your files around in transit (much like the post office does with your mail), and often cor-
rupts them. This is especially true when trying to e-mail more than one item at a time. By compress-
ing the files into a single archive, you protect them from harm as they zoom around the Internet. This
archiving is also a form of lossless compression. Lossless compression makes a file smaller without
actually reducing any of the quality (when the file is decompressed it goes back to its original size).
Compression is obviously useful if you want to preserve space on your disk, or if you just want to
make a particular cluster of files into a single, easily manageable item. After the archive is created,
you can un-archive the files by simply double-clicking the archived file. The archive is opened and
the files are safely extracted by any of a number of available tools. After extraction, the archive
remains in its original form, still full of your files.

To rename a folder, file, or other item, you must explicitly select its name. After you have per-
formed the selection correctly, the item’s name is highlighted with a lighter shade of the selection
color (remember, when items are selected, the icon is highlighted, and the name is surrounded by

a color). The lighter shade highlighting the name indicates that the entire text is selected and ready

for replacement. There are a few different methods to achieve this, depending on the way your

items appear. In any view mode select the item, and then press Return or Enter. You can also select

the item using any method you choose, then wait a couple of seconds and click the selected item’s
name (the text of the name, rather than the icon). If you issue the second click too quickly, the
computer thinks you are double-clicking and opens the document instead of selecting the name
for editing. In either case, after a brief delay, the name is selected for your editing pleasure. From
the Get Info window, you can change the name in the Name and Extension panes.

When the name is first selected, the file name is highlighted. With the file name selected this way,
you replace it completely by typing a new name. If you want to change only part of the name, you
can select that part and replace or delete it. You can also place an insertion point and type addi-
tional text.

To replace or delete part of an item name, do the following:

1. Select the name for editing. Use any of the methods described above.

2. Position the pointer where you want to begin selecting the name. When the pointer
is over the selected text, it should be shaped like the letter I.
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3. Press and hold the mouse button and drag the pointer to select part of the name. As
you drag, the text is selected.

To select one particular word in a name, you can double-click the word instead of drag-
ging across it.

4. Release the mouse button to stop selecting.

Type a replacement for the selected part of the name or press Delete to remove the
selected text.

6. Press Return to end your editing. Alternatively, you can click outside the name that
you're editing.

To insert text in an item name, follow these steps:

1. Select the name for editing. Use any of the prescribed methods.

2. Position the pointer where you want to make an insertion. When the pointer is over
the selected text, it should be shaped like the letter .

3. Click to place an insertion point. A thin flashing line (known as the cursor) marks the
position of the insertion point.

4. Type your additional text.

Press Return to end your editing. Alternatively, you can click outside the name that
you're editing.

When the desired name is entered, press Return or Enter to complete the renaming. If you decide
you don’t want to rename the item, but have already accidentally erased the original name, don’t
panic! Press the Escape key before pressing return and the original name will be restored. If you
have already pressed Return and applied the name, all is still not lost. Use the Finder’s Undo fea-
ture to restore the name. To use Undo, press 8+Z. (The Undo feature is covered in greater detail
later in this chapter.)

Naming with Cut, Copy, and Paste

While editing a name, instead of typing the name from scratch, you can use the Cut, Copy, and
Paste commands in the Edit menu. To copy all or part of an icon name, select the part that you
want to copy and choose Copy from the Edit menu. The Copy command places the selected text
on the Clipboard, which is an internal holding area. Then you can paste what you copied by select-
ing all or part of another icon’s name and choosing Paste from the Edit menu. At this point, you
can make changes to the name that you pasted. Whatever text you copied remains on the
Clipboard until you use the Copy command again or the Cut command. The Cut command works
just like the Copy command, but Cut also removes the initially selected text while placing it on the
Clipboard. Cut, Copy, and Paste operations are covered in greater detail in Chapter 5.

. Some item names cannot be selected for editing. You can’t rename such an item

RS pecause it is locked or you don’t have Write privileges for the item. You may be able
to unlock the item, but you probably can’t give yourself Write privileges. Locking and unlocking is
discussed later in this chapter.
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Some notes on naming

Mac OS X is very forgiving with regards to naming rules. With support for 255-character-long
names and all the funky symbols you can imagine, names in the Mac OS X world are limited only
by your imagination. That said, Windows machines are not so forgiving. Therefore, if you ever
intend to share your documents, you should obey naming convention rules.

B Avoid special characters, such as the infinity symbol (ee), the bullet symbol (), or the
euro symbol (€) in the file name because the Windows OS may not render these charac-
ters correctly. Because of having incorrectly represented characters in a name, the files
may be unreadable to others.

B Names cannot include colons because the Mac OS uses colons internally to specify the
path through your folder structure to a file. A pathname consists of a disk name, a succes-
sion of folder names, and a file name, with a colon separating each name. For example,
the pathname Macintosh HD:Applications:Spaces specifies the location of the
Spaces application on a startup disk named Macintosh HD. Putting a colon in a file name
would interfere with the computer’s scheme for specifying paths, so the Finder won't let
you do it.

B Although the Finder won't let you use colons in a file name, it does let you use slashes. It
is strongly advised that you never use slash characters (/ or \) in your file names.
Windows machines read these characters as indicating the path on their disks (just like
Macs use colons), and the computer will look for folders that do not exist, resulting in a
completely inaccessible document (unless your friend is smart enough to figure out how
to rename the files).

B A few things that are okay: All alphabetic letters (capital or not, for example A-Z, a—z),
Hindu-Arabic numbers (0-9), the symbols in the number row (~@#$%"&*()=+), blank
spaces, hyphens (-), and underscores (_) are universally acceptable, as are commas (,).

Get Info

Mac OS X keeps a great deal of detailed information about your files, folders, and disks beyond
what’ available in regular Finder windows. A time may come when you want to see or change
some of this information. Hidden in the Info window (also known as the Get Info pane, or just
Get Info) is the area that displays the additional critical information and enables some interesting
changes to be performed on most selected items. To bring this powerful window to light, select an
item and select Show Info from the File menu, or press 8+1. The Get Info window opens, com-
plete with basic information and bearing multiple disclosure triangles hiding various information
and control repositories.

Spotlight Comments

This field can be populated with any information you want. The expectation is that any data in this
field will improve the effectiveness of Spotlight searches. Spotlight is covered in more detail in
Chapter 3. This field can be helpful when managing a large host of files with similar names, because
users can enter information here to help distinguish files. Also, information can be entered in the
Spotlight Comments field for the benefit of others that may be using the files.
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Selecting Text with the Keyboard

With an icon name selected for editing, you can also move the insertion point or change the
selection by using the arrow keys.

T Moves the insertion point to the beginning of the name
d Moves the insertion point to the end of the name

- Moves the insertion point to the right

— Moves the insertion point to the left

Option+—  Moves the insertion point word-by-word to the right.
Option+<  Moves the insertion point word-by-word to the left.
Shift+— Selects more (or less) of the name to the right

Shift+« Selects more (or less) of the name to the left

Whether Shift+— and Shift+« selects more or less depends on the direction that you dragged when
you initially selected part of the name.

General

General is the main area of the Get Info window. The item’s kind, size, location, creation date,
modification date, and label all appear in this area. Depending on the item’s type, additional or
alternate information will appear. For example, if the selected item is a disk, information on the
Format method applied to the disk is shown, and the size information is replaced and supple-
mented with total capacity, available space remaining on the disk, and the amount of space cur-
rently in use. The Get Info window for documents also gives users the option to set the file as a
Stationary Pad or Lock the file for protection (discussed in detail later), and the Get Info window
for volumes enables you to set the volume as a Shared Folder.

Stationery Pad

Many items have the Stationery Pad check box. Checking this box turns the item into a template.
More on stationery pads and templates can be found in Chapter 5.

Locked

Like the Stationery Pad check box, many items have the locked check box. Checking this box
locks the item and prevents it from being deleted or modified. Locked files are discussed in greater
detail later in this chapter.

More Info

The More Info area is populated with more specific and often technical information about a partic-
ular file. For example, in the case of a Portable Network Graphics file, the More Info section pro-
vides the dimensions of the image, the color space, profile name, alpha channel, and the date it
was last opened.
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Name & Extension

The name of the selected item is shown in the Name & Extension section. Clicking in the box con-
taining the item’s name enables you to edit the name of the item. It is worth noting that the name
of the item is shown with its extension here. The file name extension is a three- or four-letter code
that delineates the document’s type. Changing this extension is not recommended, because it has
the potential to confuse the Finder’s ability to choose the appropriate application to open the docu-
ment with. See “Some notes on naming” earlier in this chapter regarding some general tips on nam-
ing files.

Open With

Each document has a parent application (that is, the application that by default attempts to open
it). In this area, that default application can be changed. For example, Portable Document Format
(PDF) files can be opened by Apple’ built-in Preview application or by Adobe’s Acrobat applica-
tion. Choose which application you want to open the document with by default by using the con-
venient pop-up menu. You can choose to have the selected file or all related files opened by the
newly selected parent application by clicking the Change All button. Beware: This action cannot be
undone.

Preview

If the item is a graphic file, this area displays a preview of the image. If the file is a movie file, the
preview displays a miniature version of the movie, complete with controls to play it. Some items
cannot be previewed in this area, either because the preview engine cannot render them or because
there is nothing to preview. Items that cannot be previewed include, but are not limited to, certain
text documents, folders, and disks. In this case, the Preview field will just display a full-size ren-
dering of the item’ icon.

I’'m sorry Dave, I’'m afraid I can’t do that . . .

Mac OS X doesn’t permit you to move, rename, or copy everything, and it won't let you put stuff
anywhere you want. For example, you can’t move or copy your items into another user’s home
folder. Conversely, you can’t move or rename items that belong to other users, although you may be
able to copy other users’ items into your folders.

The Finder won't let you move an item from its current location or rename it unless you have Write
privileges for the item. If you try to move an item for which you don’t have Write privileges but do
have Read privileges, the Finder makes a copy of the item instead. If you don’t have Write or Read
privileges for an item, the Finder doesn’t let you move, rename, or copy the item.

Regardless of your Write privileges for an item that you want to move or copy, you must also have
Write privileges for the destination folder. If you try to move or copy an item to a folder for which
you don’t have Write privileges, the Finder displays an alert, saying the destination folder cannot be
modified.
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Sharing & Permissions

Sharing of a file and the permissions associated with the file are complex and potentially confusing.
The basic concept is as follows: The creator of a file is the default owner of that file. The owner can
choose to share the file with whomever he pleases. Permissions are the rules that owners apply to
their files, enabling other people to work with them. The permissions can be very specific, allow-
ing visitors only to read files, and not to edit or delete them. The permissions can be cut and dried
as well, allowing total control or complete lock-out.

Locking or unlocking an item

You can use the Info window to lock files individually so that they can’t be changed. After locking
a file, you can open the file and copy it, but you can’t make any changes to its name or contents.
Additionally, the Finder does not allow you to move locked files into the Trash. The padlock in the
lower left-hand corner of the file’s icon indicates if a file is locked. Follow these steps to lock a file:

1. Select the file that you want to lock. Choose Get Info from the File menu.

2. Select the Locked option in the Info window. The Locked option appears under the
General section of the Info window. You can't change an item’s Locked option if you are
not the item’s owner.

Finding Out About the Finder

Ask most Mac users which application they use most often, and you will receive answers like
Adobe Photoshop or Microsoft Word or Safari. These answers are all incorrect. What’s the correct
answer? The Finder! The Finder is the most accessed application in the Mac OS because it is at the
heart of your environmental experience. Unlike the majority of other applications, you don't have
to do anything to make it start running. The Finder starts running automatically when you log in
and keeps running until you log out. Represented by a blue smiling computer face, the Finder’s
icon is always listed first in the Dock. The Finder is responsible for generating the desktop, main-
taining its own windows, and controlling the interaction between files, their host applications, and
the hard drive. Of course, this makes the Finder not only the most commonly used, but also the
most important and potentially most fragile application. The old Macintosh OS 9 Finder was less
of an application, and more of a system function. Any attempts to recover from a Finder problem
would typically be met with a user shouting at the screen and/or punching the keyboard as the last
few hours of work disappeared in a reboot. The Mac OS X Finder operates much like other appli-
cations; able to recover from errors — even able to be relaunch when needed — on the fly, without
forcing a reboot or damaging a user’s work in other applications

Finder-specific menus

Earlier this chapter discussed the menu bar in general. Most applications make their own additions
to the menu bar, or they may eliminate some menu items, or remove the menu bar altogether!
And, yes, even the Finder, the core system application, has its own unique menus that are added to
the menu bar.
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Finder menu

The application menu is the first menu after the Apple menu, and its named for the active applica-
tion. Thus, while in the Finder, the menu is named Finder. As with all application menus, this menu
is populated with commands that pertain to that specific application. Selecting the About Finder
option opens a window containing copyright information on the Finder as well as stating which
version of the Finder you are using. (Apple releases updates all the time, which you can keep up
with via the Software Update preference pane as covered in Chapter 1.) Other menu options in the
Finder menu include the command to Secure Empty Trash, and the Services drop-down menu that
contains various additional features and commands. The Services menu and its various elements
are covered in Chapter 9.

Go menu

The Go menu is one of two Finder-specific menus available in the menu bar. The Go menu is
designed to offer the user a few convenient shortcuts to commonly used locations or items. By
selecting these items, a new Finder window opens, displaying the selected location. See the Go
menu in Figure 2.31.

Choose Computer, Home, Desktop, iDisk, or Applications from the Go menu to display the contents
of the corresponding folder in the front Finder window. (If no Finder window is currently open, a
new Finder window appears.) Each Go menu item has handy keyboard shortcuts. Computer is
88+Shift+C, Home is 88+Shift+H, iDisk is 8+Shift+I, and Applications is 38+Shift+A.

FIGURE 2.31

The Go menu contains shortcuts to numerous commonly used locations.
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Recent Folders

The Recent Folders submenu of the Go menu lists the last 10 folders you displayed in the Finder.
This submenu is similar in concept to the Recent Items menu in the Apple menu, which lists appli-
cations and documents that you have recently used. Like the Apple &> Recent Items submenu, the
Go = Recent Folders submenu has a menu choice for clearing the current list of recent folders.
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Go To Folder

If you know the exact name and path to the folder you want (and you type well), choose Go = Go
To Folder (or press the keyboard shortcut 38+Shift+G). The Finder displays a dialog box in which
you type the path and name of the folder you want. This is far from the traditional Macintosh
graphical interface, but it is one near and dear to the hearts of folks accustomed to Unix and
MS-DOS environments.

A complete path to a folder begins with a slash character (/) and is followed by the names of every
folder from the outermost folder to the folder that you want to open, with an additional slash
between folder names. For example, /Applications/Utilities is the path to the Utilities
folder within the Applications folder.

If you don't start the pathname with a /, the Finder looks for a relative path, one that starts in the
current folder. For example, if the Applications folder is open in the front Finder window, you can
open the Utilities folder by typing Utilities in the Go To Folder dialog box.

B Unix pathname shortcuts all work in the Go To Folder dialog box. For example, if you're
in a folder on another volume and want to be in the Sites folder of your home folder,
|ust press 8+Shift+G to display the Go To Folder dialog box and type ~/Sites to be transported.
Similarly, to get to the Public folder of another user with the short name eabrahams, you would type
~eabrahams/Public. Confused? See Chapter 23 for more on Unix.

Back

If you want the front Finder window to go back to the folder or disk that it last displayed, choose
Go = Back (or press 8+|). You can continue going back by choosing Go = Back again. When the
front Finder window can’t go back any more because it is displaying the first folder or disk that it
ever showed, the Back item is disabled (dim) in the Go menu. The Back item in the Go menu is
equivalent to the Back button in the Finder window toolbar.

Connect To Server

The Go menus final choice provides access to file servers, either on your own network or on the
Internet. Choosing Go = Connect To Server (or pressing 8+K) displays a dialog box in which you
specify the server that you want to connect to. This dialog box provides a pop-up menu of recent
servers, in addition to a browser area in which you find available servers on your local network.

View menu

The View menu contains commands that change the style and method of items presented via the
Finder. In addition to switching between view modes (covered later in this chapter), the View
menu enables users to edit some specific view details for each view mode. The commands apply to
Finder windows and the desktop, and typically affect only the foremost window (or the desktop if
no windows are selected or open). Figure 2.32 shows the View menu.
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FIGURE 2.32

The View menu includes options to adjust the appearance of items in a Finder window or on the desktop.
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The View menu contains the following commands:
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as Icons: This switches the current Finder window to the Ilcon view mode. You can
change this setting by clicking the icon button at the top of the Finder window. The key-
board shortcut to perform this command is 38+1. This command is available only if a
Finder window is open and active.

as List: This switches the current Finder window to the List view mode. The keyboard
shortcut to perform this command is 8+2. This command is available only if a Finder
window is open and active.

as Columns: This switches the current Finder window to the Column view mode. The
keyboard shortcut to perform this command is +3. This command is available only if
a Finder window is open and active.

as Cover Flow: This switches the current Finder window to the Cover Flow view mode.
Adopted from iTunes, this view is new to the Finder. The keyboard shortcut to perform
this command is 8+4. This command is available only if a Finder window is open and
active. This view is discussed in greater detail in the “Working in Cover Flow view”
section.

Clean Up: This command is available with icon views only. Clean Up neatens up the cur-
rent window’s contents by aligning the items on a grid.

Arrange: This command is available with icon views only. Arrange reorganizes a win-
dow’s contents both to a grid and to a specified factor. You specify the sorting factor via
the submenu: The options are by Name, Date Modified, Date Created, Size, Kind, and
Label.

Hide Toolbar: This command does more than just turn off the toolbar in the active
Finder window. In fact, hiding the Toolbar results in a very different-looking and much
leaner Finder window. If the toolbar is already hidden, the menu option reads Show
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Toolbar, and selecting it returns the toolbar to view. The keyboard shortcut for this com-
mand is 8+Option+T. This command is available only if a Finder window is open and
active.

B Customize Toolbar: This command opens a dialog box that enables users to customize
the toolbar according to their needs. This command is available only if a Finder window
is open and active.

B Hide Status Bar: This command is available only for Finder windows that are in the
simpler Hide Toolbar view. This command turns off the status bar in the active Finder
window. If the status bar is already hidden, the menu option reads Show Status Bar, and
selecting it returns the status bar to view.

B Show View Options: This menu command opens a dialog box where the current view
mode can be edited and adjusted.

Finder windows

Typically, you navigate your computer’s myriad of files and folders via Finder windows. Finder win-
dows graphically represent the contents of particular folders or disks, and can present this informa-
tion in many ways, each with its own characteristics and advantages. A standard Finder window is
a good place to review many of the most common objects.

Mac OS X gives you a few ways to create new Finder windows:

B Choose File &> New Finder Window.
B Click any folder or disk icon and choose Open from the Finder menu.

B (Click the Finder icon in the Dock. If there are open Finder windows, this brings the
windows to the front, with the exception of minimized Finder windows.

B If the Finder is the active application, press 8+N. (Identifying active applications is
discussed later in this chapter.)

B Double-click any folder or disk icon visible on the desktop.

B Double-click any folder or disk icon in another Finder window with the toolbar hidden.

W Press 8 while opening (double-clicking) a folder or disk that appears in a Finder window
with the toolbar visible.

In this new Finder window, you are confronted with a number of interesting controls and surfaces.
Some are large and obvious, such as the sidebar, the toolbar (both discussed later in this chapter),
and a few icons in the main window pane (either the elements of your home folder or the root
level of your hard disk). Figure 2.33 displays an annotated diagram of a basic Finder window.

% with all of your files as leaves sprouting out from various branches (the folders) that pop
out along the way up the trunk (the disk/volume).
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Finder windows are the primary tools used to view available files within folders or disks. These are some
items unique to Finder windows.
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Finder windows are composed of the standard window controls described earlier in this chapter, in
addition to a number of unique additional tools to modify the window’s appearance and behavior.

B Sidebar: The sidebar is the area on the left side of a Finder window that contains short-
cuts to commonly needed destinations within a user’s system. The sidebar can be edited
to suit your needs. Editing the sidebar is discussed later in this chapter. To use a sidebar
item, simply click its icon. The current window displays the sidebar item’s contents. For
example, if you are currently reviewing your home folder in a Finder window, and then
click the Macintosh HD icon in the sidebar, the contents of the root level of the hard disk
appear in the main window, rather than the home folder. Pressing and holding 8 when
clicking a sidebar item opens a completely new Finder window in front of the original
window. The new window displays the selected item’s contents. Holding down Option
while clicking an item closes the original window and opens a new one displaying the
selected item. The sidebar in Mac OS 10.5 has notably changed. Shortcuts are now
organized into the following categories:

B Devices: Lists hard disks, iDisks, CDs, and so on.

B Shared: Computers on the same local area network are listed here. Not only can you share
your screen or control the other computer (administrator privileges are required), but you
can do so without the use of Apple Remote Desktop or any third-party applications. To
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share your screen, simply click the icon of the computer that appears below the Shared
Computers heading in the Finder sidebar and click Share Screen. You will be prompted
for an administrator password. After authenticating, the computer screen appears in a
new window. See Figure 2.34. To end the session, simply close the window.

FIGURE 2.34

Using the Share Screen feature, you can check in on your child’s computing activity
from another room.

Places: Organizes the popular destinations on your hard disk, like your Desktop, Home
folder, Application folder, and Documents folder.

Search For: Sorts the data that you have created, opened, or modified into three categories:
Today, Yesterday, or Last Week. If on the other hand you want to sort the data by type, you
can choose to see all of the Images, Movies, or Documents stored on your hard disk.

Toolbar: The toolbar is located just below the title bar, and contains very useful tools to
perform commonly used functions with a single click, rather than through complex com-
mands. It functions as an adjunct to the menu bar. A new addition to the toolbar is Quick
Look and the Cover Flow icon. Quick Look is a great way to peek into documents, and
the Cover Flow view is a dramatic way to peruse your files and folders in the Finder. It
may not be the view you choose on a daily basis, but it's an awesome way to browse
through your images. The toolbar can be edited to suit your needs or style. Changing the
toolbar to suit your needs is discussed later in this chapter.
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Toolbar Hide/Show button: Another element of the title bar in all Finder windows, the
toolbar Hide/Show control is a pill-shaped button. It is located in the top right portion of
the title bar. Click this button to hide the toolbar and most of the Finder-specific elements
of the window. The result of turning off the toolbar is to produce a radically different-
looking Finder window, with no toolbar, no sidebar, and no metallic border. The look

is very minimal, which will probably make the clean-freaks or OS 9 addicts out there
happy. If this reduced window mode is already in effect, click this button to show the
toolbar.

Action button: The Action button looks like a gear with a downward facing black trian-
gle next to it. The Action button performs functions nearly identical to a contextual
menu. By clicking the Action button, a list of commands is presented based on the type
of item or window selected.

Quick Look button: This new addition to the Toolbar looks eerily like an eye. Quick
Look offers a full size preview of files. There are three ways to access this feature: via the
Quick Look button in the toolbar, via the contextual menu, or by simply selecting an
item and pressing the Spacebar (this is my favorite way); press the space bar again and
the preview is closed. You have the option to view the items in full screen, or you can flip
through documents that contain more than one page. Chapter 5 digs deeper into Quick
Look.

Back: A standard button in the toolbar, the Back button returns the Finder window to the
previous folder that was opened or viewing mode that was selected.

Forward: Also a standard button in the toolbar, the Forward button moves forward into
a selected folder or undoes a click of the Back button.

View mode selectors: The view mode selectors are four buttons to the right of the Forward
and Back buttons. These buttons allow easy switching between the four Finder window
view modes: Icon, List, Column, and Cover Flow views. Each mode is illustrated by a
distinct icon; the Icon view selector looks like four icons arranged in a square, the List
view selector resembles a list of information, the Column view selector looks like three
columns, and the Cover Flow icon is a box with three vertical lines on the left and right
side. Click any of these buttons to switch the current Finder window to the desired mode
of view. These view modes are discussed in detail later in this chapter.

Search field: It all too easy to lose track of files or folders within the maze of your com-
puter’s directory. This tool makes finding the lost files easy. Located at the top right of
every Finder window, the Search field performs a dynamic file search. Start by clicking
the magnifying glass symbol next to the empty text field and select where you want to
begin searching. Say for example that you are looking for an e-mail from an old friend,;
type the name of the sender or the subject of the message (if you can recall it). The cur-
rent window depopulates and begins displaying all files and folders that contain the let-
ters typed. This search field works dynamically, so each letter typed refines the displayed
content. When you can see the file you are seeking, simply stop typing and double-click
the file to open it, or open the file using any of the other methods covered in Chapter 5.
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B File Path: The File Path displays the location of the currently selected file and appears at
the bottom of the Finder window, when in the Search For mode or when searching for a
file. Double-clicking a folder in the File Path field opens a new Finder window. Meanwhile,
double-clicking any document in File Path opens the document.

M Status bar: The status bar appears at the bottom of every Finder window. However, the
status bar does not appear when the Toolbar is suppressed. The status bar presents infor-
mation concerning the window’s contents. The status bar also displays the amount of
unused storage space on the disk or other volume that contains the folder whose contents
appear in the window. Also, if you do not have write privileges for a folder, disk, or other
item whose contents appear in the window, a small icon that looks like a crossed-out
pencil appears near the left end of the status bar. Privileges are covered in Chapter 12.

Finder window views

Each Finder window can be viewed in one of four view modes, each with its own advantages and
disadvantages. These choices are Icon, List, Column, and Cover Flow views. If you think you've
seen Cover Flow before, you're right. Cover Flow was first introduced in iTunes as a nifty way to
view your music and album artwork simultaneously. This view mode is especially useful when
browsing through images. Which mode or modes you use is completely up to your tastes or
circumstances.

Choosing a view
Every view has its purpose. You can choose your view format for the active Finder window in one
of two ways:

B Choose a view style from the Finder’s View menu. Select one of the four choices: as
Icons, as List, as Columns, or as Cover Flow.

B Click the appropriate part of the View Mode Selector button in the window’s tool-
bar. Click the appropriate button to view as Icons, as a List, as Columns, or as Cover
Flow.

Working in an icon view

The icon view is the original Finder view, dating back to the very first Macs shipped in 1984. In
Mac OS 10.5, the icon view has been updated to provide more information. The icons of Text Edit,
Preview, iPhoto, Portable Network Graphics, and Microsoft Office application files now give you a
preview of the data contained in the file. Before Leopard, this functionality was limited for the most
part to applications like Photoshop. In addition to displaying the icon view with a custom icon that
gives you a preview of the files contents, picture documents advertise the size of the image directly
beneath the file name. You select an icon by clicking it, typing the first part of its name, or pressing
the arrow keys. You can select multiple icons by clicking and dragging your pointer across them or
by 88+clicking or Shift+clicking each icon in turn. The biggest advantage of the icon view is the
ability to preview a document before opening it.
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Cleaning up

If the icons in an icon view are in disarray, you can have the Finder align them in neat rows and
columns. You clean up the active window by choosing View &> Clean Up. You can clean up individ-
ual icons by pressing and holding the 3 key while dragging them individually or in groups.

Arrange by Name

You can also have the Finder alphabetize the icons and align them in rows and columns. Do this by
choosing View = Arrange by Name. The Finder can also keep the icons in a window arranged for
you. Configuring automatic icon arrangement in the Finders View Options window is covered later
in this chapter.

Working in a list view

List views pack a lot of information in a window. Although items appear in a list format, columns
enable you to sort the information by the file name, date modified, size, and kind. You can use the
columns to help sort and organize the items. You can sort the list by any of the column headings at
the top of the view. Folder contents appear in an indented outline format. Apple has streamlined
the list view by shading alternate rows, thereby making it easier to follow the facts of the file across
columns from Name to Kind. The main advantages of the list view are the ability to select multiple
items from different folders, the variety of navigation tools available, and the ability to sort lists by
more than just name.

Changing the sort order

When you initially view a window as a list, the items are arranged alphabetically by name. A quick
glance at the column headings tells you the sorting order. The highlighted column heading indicates
that the items are being sorted by that column. In a Finder window, you can change the sorting
order by clicking one of the column headings near the top of the window. For example, to list the
items in the order in which they were last modified, click the Date Modified heading. Click the
heading again to toggle between ascending and descending order. An arrowhead at the right end of
the heading indicates the sort direction.

Rearranging and resizing columns

The columns of a list view are adjustable in a Finder window. This is helpful if an item’s name is too
long to be displayed in the current layout, as indicated by the name truncated by an ellipsis (...).

To change the size of a column, follow these steps:

1. Position the mouse pointer to the right edge of a column heading. (The pointer is in
the right place for resizing a column when the pointer transforms into a vertical line with
left- and right-pointing arrows coming out of it).

Click and hold the mouse button.

Drag left or right.

i play the entire name in a help tag by positioning the pointer over the name and waiting
a few seconds. If you can’t wait, point at the name and press Option to see the help tag immediately.
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You can also change the order in which columns appear. Simply click and drag the column head-
ing to the left or right. As you drag, the pointer transforms to a hand and you see a pale image of
the column you are moving. Unfortunately, Apple doesn't allow you to move the Name column.
However, you can achieve the same end by moving other columns in front (to the left) of the Name
column.

Navigating a list view with disclosure triangles

When reviewing a folder’s contents in List view, you don't have to open disks or folders in new
windows to navigate deeper into your folder structure. A list view allows you to expand the folders
via a method similar to an indented outline. Instead of opening a folder or disk in a new window,
you can see the contents of a disk or folder by clicking the disclosure triangle to the left of its icon.

Disclosure triangles appear next to folder names if the folder contains additional items, and they
tell you whether the folders are expanded or collapsed. If a triangle points to the right, the folder
next to it is collapsed, and you cannot see its contents. If the triangle points down, the folder is
expanded, and below the folder name you can see a list of the items in the folder. The Finder dis-
plays list views in an indented outline format. The levels of indentation in the outline show how
folders are nested. The indented outline provides a graphical representation of a folder’s organiza-
tion. You can look through and reorganize several folders all in one window. Figure 2.35 shows an
example of a list view with both expanded and collapsed folders.

To expand a folder, click the triangle to the left of the folder’s icon. When you expand a folder, the
Finder remembers whether folders nested within it were previously expanded or collapsed and
restores each to its former state.

To collapse a folder, click the down-pointing triangle to the left of the folder’s icon. The triangle
returns to the right-pointing orientation, and the contents can no longer be seen.

FIGURE 2.35

A list view with expanded and collapsed folders
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FIGURE 2.36

To expand a folder and the first level of all subfolders within it, press Option while clicking the dis-
closure triangle. Repeating this action collapses the folder and the first level of subfolders.

Working in a column view

This column view derives its layout from the NeXT browser view, and it first appeared on the Mac
in the shareware utility, Greg’s Browser, back in 1989. Understanding the column view and becom-
ing comfortable with its use is relatively important because you see column views in the dialog
boxes for opening and saving documents within applications (as explained in Chapter 5). The
main advantages of the column view are the ease of reviewing the path to a particular item and the
wealth of information displayed when previewing items. The disadvantage is the lack of the sorting
options present in this view.

A column view shows a folder and its contents in the same window through the use of limitless
replicating columns. When you select a folder in a column view, that folder’s contents appear in the
next column to the right. The deeper you explore, the more columns become available. When you
select an alias of a folder, Mac OS X resolves the alias and the Finder displays the original folder’s
contents in the next column to the right. When you select a file, some basic information about the
item, as well as its icon or a preview of its contents, appears in the next column to the right (see
Figure 2.36). Whether you see a file’s icon or a preview of its contents depends on the type of file.
For an application, you always see an icon and some facts about the application including the
name, kind; size; date the application was created (or installed), modified, or last opened; and the
version of the application you are running. For some types of documents that contain text or
graphics, you see a preview. When previewing a graphic in column view, all of the file information
mentioned above appears, but the version is replaced with the graphic’s dimensions.

When viewing an image in column view, a preview of the image, as well as the file name, kind, size, date
it was created, modification date, the last time the file was opened, and the file’s dimensions appear.
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A column view differs markedly from an icon view or a list view in how much of the folder struc-
ture you can see. Where an icon view shows only one folder and a list view shows one folder plus
the folders it contains, every column view can show any part of the folder structure on any disk
that’s available on your computer. By scrolling a column view to the left, you can traverse the folder
hierarchy to the Computer level. By scrolling to the right, you can traverse the folder hierarchy in
the other direction until you reach the currently selected folder or file.

Unlike list or icon views, you have no control over the sorting order in a column view. Items in
each column are always listed alphabetically. (Actually, the order of items is based on the character-
set ordering established for your system and language.)

Resizing columns
Column width is adjustable in a column view. You can adjust the widths of all columns uniformly
or the width of a single column as follows:

B To resize one column, drag the handle at the bottom of the column divider.

B To resize all columns at once uniformly, press and hold Option while dragging the handle
at the bottom of any column divider to the right or left.

Previewing files in a column view

One of the column view’s nicest features is that, when you select certain types of document files,
you see a preview of that document’s contents in the rightmost column. Previews appear for several
types of documents, including plain text, PDE sound, movie, and graphics files. For a document
with multiple pages, the preview shows the first page. The preview for a sound or movie appears
with a small QuickTime controller, which enables you to play a song or watch a preview of a
movie. QuickTime is discussed in Chapters 6 and 7.

Back in the day, preparing the preview for a long PDF document or even a very large
plain text document could take a long time and cause the Mac to be unresponsive.
However, with Quick Look you can preview an entire PDF or text file regardless of length.

Pathfinding alternative

As noted, a column view gives you a quick look at the path through the folder structure from the
Computer level to the item or items displayed in the rightmost column. However, you don't have
to be in a column view to obtain this path information. At the top of any Finder window, the title
bar tells you the name of the folder you are in. When you press the 3 key and click the name of
the folder, a menu pops up, showing the hierarchy of folders traversed to get back to the Computer
level. The current folder is at the top of the pop-up menu, and the Computer level is at the bottom,
as shown in Figure 2.37.
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See the path through your folder structure by 3+clicking the title bar of a Finder window.
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Working in Cover Flow view

Taken straight out of the pages of iTunes, Cover Flow is the newest addition to the Finder views.
By far the prettiest view, the Cover Flow view is a combination of the Icon and the List view. Split
horizontally, the upper half presents icons of the items in a runway-like display, and the bottom
half displays the items in a list (see Figure 2.38). As a result, you can modify the sorting order of
items just as you would in List view. Navigating through items in the Cover Flow view is simple:
Use the scroll bar directly beneath the icons to flip through files or press the up and down arrows
in the list. Double-click a folder to reveal its contents. Not only do you get a preview of the file,
you can also click through multipage documents as if you were turning pages in a book, or play a
QuickTime movie.

FIGURE 2.38

The Cover Flow view displays your images and documents in stunning array.
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Setting Finder Preferences

The Finder has a number of preference settings that affect the appearance of icons on the desktop,
the behavior of Finder windows, label colors, emptying the Trash, showing extensions on the
names of files, and more. You change these preference settings by choosing Finder &> Preferences.
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The Finder Preferences window appears. There are four available subpanes to the Finder
Preferences window. Each is shown in Figure 2.39.

The Finder’s preference settings affect desktop icons, Finder windows, the Trash, and file extensions. Note

the expanded sidebar preferences.
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Finder Preferences offers the following options:

Show these items on the Desktop: Select the types of items that you want the Finder to
display on your desktop. These items are shown together with any additional items located
in the Desktop folder of your Home folder. All items appear at the Computer level of
your workspace regardless of the settings here.

New Finder windows open: Select what folder you want to appear when you create a
new Finder window. The default, and recommended, option is your Home folder. Other
options include the Documents folder, Macintosh HD (root level of the disk), iDisk (if
available), the Computer level of your folder structure, or Other. Selecting Other opens a
dialog box, where you can select the desired folder and click Open. The Home folder is
recommended because this is the main repository for all of your personal data, including
documents, music, pictures, and more.

Always open folders in a new window: Select this option to reverse the Mac OS X
Finder’s practice of navigating within a single window. This makes the Mac OS X Finder
spawn windows in the same way as the old Mac OS 9 Finder.

Open new windows in column view: Select this option, and the Finder opens all new
windows in column view. Of course, once the window is opened, you can switch to any
desired view mode through the methods covered earlier in this chapter.

Spring-loaded folders and windows: If you drag an icon over a closed folder, the folder
automatically opens after a brief delay. This delayed opening is called spring-loading. This
slider sets the time delay between when you drag an icon over a folder and when that

folder springs open. As the note below the slider points out, if you want a folder to open
immediately, drag the icon over the folder, and then press the Spacebar on the keyboard.

Labels: Each individual file or folder in Mac OS X can have a colored label applied to it,
affording users another way of visually sorting through their files. In the second subpane
of the Finder Preferences window, the labels can be named to more accurately reflect their
purpose. By default, the names are simply the name of the color.

Sidebar: This subpane of the Finder preference pane displays the list of standard items
shown in the sidebar. Deselecting items here removes them from the sidebar.

Show all file extensions: Select this option if you want to see the three or four character
name extensions (suffixes) for all files that have them. Displaying the file extension gives
you a clue as to what type of file you may have been given.

Show warning before emptying the Trash: Deselect this option if you want the Finder
to empty the Trash without first prompting you to confirm the action. If this option is off,
the Finder also deletes locked items from the Trash without any warning. It is recom-
mended to leave this option selected, to prevent accidental erasure of files.

Empty Trash securely: Select this option if you want to securely empty your Trash each
time you select Empty Trash.

Modifying Finder windows

So far this chapter has discussed how to view a Finder window as icons, a list, columns, or cover
flow; how to clean up an icon view and change the sorting of a list view; and how to show and
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hide the toolbar at the top of any Finder window (which results in a rather different look!). These
are only some of the ways you can customize Finder windows. Other methods for tuning Finder
windows include suppressing the sidebar and customizing the toolbar. These methods are covered
in this section.

Customizing the toolbar

The default toolbar consists of a number of buttons — Back, Forward, View Mode Selectors, Quick
Look, and Action —and the Search field. Apple enables you to remove any of these buttons, add
others, and arrange them any way you want. You can also set the toolbar to display the buttons as
named icons, icons without names, or names alone. To make these changes, with any Finder win-
dow active, choose View &> Customize Toolbar. The active Finder window changes to display the
Customize Toolbar dialog box shown in Figure 2.40.

FIGURE 2.40

Add, remove, and rearrange buttons in a Finder window’s toolbar by using the Customize Toolbar dialog box.
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With the Customize Toolbar dialog box open, change the toolbar by doing the following:

B Add buttons: Drag any of the optional buttons to the toolbar from the main part of the
dialog box. You don’t have to add buttons only to the right end of the toolbar. If you drag
a button between two buttons in the toolbar, they move apart to make room for the but-
ton you're dragging. If the toolbar is full of buttons and you drag another button to the
toolbar, buttons that don't fit on the toolbar appear in a pop-up menu. To see this menu,
click the arrow that appears at the right end of the toolbar. Click the Done button to
complete your toolbar customization.
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B Remove buttons: Drag buttons away from the toolbar.
B Rearrange buttons: Drag buttons to different places on the toolbar.

B Revert to default buttons: If you've customized the toolbar and want to get back to the
default set of buttons, drag the boxed default set from the lower part of the dialog box to
the toolbar to replace whatever is currently there.

B Show: Show items as icons with names, icons only, or names only by choosing from the
Show pop-up menu at the bottom of the dialog box. Figure 2.41 gives examples of each
toolbar mode. The Use Small Size check box makes the toolbar icons smaller, conserving
space.

FIGURE 2.41

A Finder window’s toolbar displaying just icons (top), both icons and text (middle), and only text (bottom).
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B Add icons as buttons — even without the Customize Toolbar dialog box open! Just drag

=5 folders, files, or disks from anywhere on your computer to the toolbar while pressing
and holdmg the 8 key, and the items become buttons there. For example, if you create a folder for
a particular project within your Documents folder, drag its icon to the toolbar to make it accessible
with a single click. To remove items, use the Customize Toolbar dialog box; however, the easiest way
to remove items is to press and hold 8 and drag the item out of the toolbar. The item disappears in a
puff of smoke.

E Clicking a folder button in the toolbar opens the folder in the same window. If you
% 38+click a folder button in the toolbar, the folder opens in a new Finder window.

Additional toolbar buttons

As shown in Figure 2.40, there are numerous controls available for the toolbar. Each has its use:

B Path: The Path tool when clicked displays a pop-up menu showing the file hierarchy
path to the current folder. Selecting any of the folders in the path opens that folder within
the active window. This can also be performed by 88+clicking the title bar.

B Eject: This tool ejects any selected disks or disconnects server volumes. The contextual
menu for each disk or volume offers the same option.

B Burn: If your computer is equipped with a CD or DVD burner, this tool opens the Burn
disk dialog box.
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B Customize: This tool when clicked opens the Customize Toolbar window.

B Separator: The Separator is a simply vertical line that serves as a visual dividing line
between items.

B Flexible Space: This item is simply a blank space, approximately the same width as
other tools. The Flexible Space item fills all space available in the toolbar. Placing a flexi-
ble space between items pushes items on both sides to the far left and far right sides.

B New Folder: Clicking this tool creates a new folder in the active window. This action can
also be performed by pressing Shift+88+N.

B Delete: This tool moves selected items to the Trash.

B Connect: Clicking this tool opens the Connect To Server dialog box. This dialog box can
also be opened via the Go menu, or by pressing 38+K. (The Connect To Server dialog box
is discussed in Chapter 12.)

B Get Info: This tool opens the Get Info window for any selected item. This window can
also be opened by pressing 88+1.

B iDisk: Click this tool to open your iDisk (a feature of Apple’s .Mac service, covered in
Chapter 14).

B Search: Adds a search field (linked to Spotlight) to the toolbar.

B Quick Look: One of the many new features in Mac OS 10.5, Quick Look gives you a pre-
view of a file without launching its supporting application.

Setting View Options

The Finder in Mac OS X provides still more ways to tweak the basic icon and list views. This sec-
tion discusses the adjustments you can make to icon and list views in the View Options window,
which you display for an active window by choosing View &> Show View Options. The options in
this window are different for Icon, List, Column, and Cover Flow view, as shown in Figure 2.42.

The View Options window displays the settings of the folder, disk, or other item whose name appears
in the title bar of the active Finder window. If you make another Finder window active (bring it to
the front), the View Options window changes to show settings for the item named in this Finder
windows title. Therefore, you can see the View Options settings only for one folder at a time.

The View Options settings don't actually apply to the active Finder window. The View Options set-
tings actually apply to the folder, disk, or other item appearing in the active Finder window. The
settings for the folder shown in a Finder window rema